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Chapter 1

INTRODUCTION TO MAPLE
Maple is a computer algebra system developed in Canada, initially at the University of
Waterloo. It is now owned and developed by a company called Maplesoft. Maple runs on a
number of operating systems, including Microsoft Windows, Mac and Linux. The current
version of Maple is Maple 2017 and this version is installed in the School of Mathematics
and Statistics labs and also available from the bookshop if you wish to buy a copy for
your own use. In the School’s labs, we have customised the settings of Maple. If you have
your own copy of Maple, you should read section 3.2 that explains how to apply the same
settings to your copy.

These Notes cover what you need to know about Maple in MATH1131/1141 and
MATH1231/1241. They are also useful for other Maple based first year courses, but cover
more material than is required. In addition, there are a number of Maple lessons available
on Moodle, see section 1.6.

If you want to know more, there is lots of information in Maple’s in built help, on the
web or in the many books on Maple — some of them are listed in section 2.24.

1.1 What Does Maple Do?
A calculator (or a computer with numerical computation software) can do things like

• evaluating a function at a point

• find an approximate value for a definite integral like

∫ π

0

x sin(x) dx ,

but it CANNOT tell you that

•
∫
x sin(x) dx = sin(x)− x cos(x)

• d

dx
xx = xx(1 + ln x)

• the exact roots of x2 − 2x− 2 are 1±
√

3 .

• the solution of a general quadratic ax2 + bx+ c is (−b±
√
b2 − 4ac)/2a

Maple can do ALL these things — and much more as well. The following list shows just a
few (in fact a small fraction) of the things which Maple can do. (Some of these are things
which you will not understand now, but you will by the end of the year.)

• differentiate functions;
• find indefinite integrals for many functions;
• evaluate many complicated limits;
• find exact solutions for many algebraic equations, including some with arbitrary

coefficients;
• perform algebraic operations on polynomials and rational functions;
• plot graphs of functions of one or two variables;
• solve many classes of differential equations;

1
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Figure 1.1: Maple in the Red-Centre labs

• perform linear algebra operations, such as multiplying matrices.

In addition, it can link to other applications and be used to create interactive docu-
ments.

1.2 The Maple Window
This chapter (and chapter 2) will tell you as much about Maple as you need to know

in order to complete your first year Maple assessments.

In your first year mathematics courses you will use Maple via its Graphical User
Interface (GUI). To start Maple click on the Maple Application Icon in the task bar (as
described in the lab notes). After some time, a Maple window, similar to that shown in
figure 1.1, will appear. Note that the window shown is Maple in the Red-Centre labs. If
you have your own copy of Maple it will appear slightly different. For more details, see
Chapter 3.

To open a blank Maple worksheet, click on the “New Worksheet” tile that is the second
from the left in the top row of tiles. Figure 1.2 shows the Maple window with a blank
Maple worksheet open in the second tab. This window contains

• a menu bar across the top with menus:

File Edit View Insert Format . . . . . . Tools Window Help

some of which are described below;

• a tool bar immediately below the menu bar, with button-based shortcuts to com-
mon operations;
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Figure 1.2: Maple in the Red-Centre labs

• a context bar directly below the tool bar, with controls specific to the task being
performed;

• a window, containing a Maple prompt [>, called a worksheet;

• a status bar at the bottom, with boxes marked Ready, Time: and Memory:.

Note: Throughout this chapter (unless otherwise stated) we will use ‘click’ to mean
‘click the left mouse button’.

You can close Maple windows like most other applications by selecting Exit from the
File menu. If you have modified any worksheets ‘dialogue boxes’ will appear, asking
you if you wish to save each of those worksheets. You have to click on the appropriate
response before the Maple window is closed.

1.2.1 Math Palettes

On the left bar of the Maple window you can see two small triangles. Clicking on the
right pointing ones will open up the panel of math palettes. The palettes can be used to
quickly enter some of Maple’s commonest command (such as diff and int). If you wish
to use them you may, but you will have to play with them yourself, as no instructions are
given in these Notes. Maple’s default settings has this panel open.

To close down the math palette panel, click on the small left pointing triangle at the
top of the separator between the palettes and the main Maple worksheet (see figure 1.2).
If you do this, Maple will remember and will not re-open the palettes next time you start
Maple.
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1.3 Using an Maple Worksheet
For an online or laboratory Maple test you will need to create and save a Maple

worksheet that you will use for solving the problems we give you. Commands are typed
in this worksheet at the prompt which is a > following a [. The cursor (a vertical line)
shows where typed characters will appear in the same way as most other applications you
will use on a computer.

1.3.1 Managing several worksheets
It is possible to have several Maple worksheets active at the same time. If you import

or open a worksheet you have already saved (see section 1.4), or click on New in the File
menu, a new worksheet is opened. This new worksheet acts like a separate copy of Maple,
although it is possible to change this behaviour (see 3.11.1 on changing the Kernel Mode).

1.3.2 Types of Regions in the Worksheet
Figure 1.3 shows a Maple worksheet with some completed work. It is divided into

execution groups consisting of lines linked together by a left square bracket [ . An
execution group either contains some calculation and possibly its result, or has some text
explaining or commenting on the calculations. The former type is split onto two regions:
an input region, and an output regions.
An input region is one in which you type your commands, e.g. int(sin(x),x); .
An output region contains either the result of a Maple command, such as

−cos(x)

in figure 1.3, or messages from the Maple processor, such as
Error, invalid input: diff expects 2 or more arguments, but received 1

It is placed in the same execution group as the corresponding input region.
A text group is for comments that you type in to explain what is happening (see

section 1.3.6). An example of this in figure 1.3 is the line

The following is the integral of x*sin(x)

Input and text regions can be edited, but output regions cannot (although they can be
deleted or copied into other regions).

1.3.3 Entering Maple Commands
To enter a Maple command into the active worksheet:

move the mouse pointer to an input region in the Maple window
type the command you want to execute
add a semicolon ; or a colon :
press <Enter>.

For example, the command

diff(sin(x),x);
will display the result cos(x) — which is the derivative of sin(x) .

Every Maple command must be followed by a semicolon ; or a colon :

If you use a semicolon then the result of the command will be displayed. If you use a colon
then the result will not be displayed. Most of the time you will want to use a semicolon.
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Figure 1.3: A Maple Worksheet

If you press <Enter> without typing a colon or semicolon, Maple will warn you, insert
a semi-colon itself and try to execute your command if it looks complete to Maple. This
may be what you want but it might not be, so you have to be careful. If the command
does not look completed, (for example you are using a loop, see 2.20) then you will get a
warning message like

Warning, premature end of input, use <Shift> + <Enter> to avoid this message.

which you can ignore if you want and continue with the command. Thus you can
enter commands too long to fit on a line (for example, a large matrix). Just press
<Shift>-<Enter> at a convenient point (such as the end of a column of the matrix
— but NOT in the middle of a word or number) and continue on the next line.

Exercise If you have not already done so, start Maple. Type the following commands
(you may omit the words after the # on each line). After each command, press
<Enter> and wait for the result to appear before entering the next command.

diff(x^3,x); # a derivative

int(x^2*sin(x),x); # an integral

solve(x^2-2*x-2,x); # roots of a quadratic

limit((3*x+4)/(5*x+6),x=infinity); # a limit as x goes to infinity

The results you get from this exercise should be:

3x2

−x2 cos(x) + 2 cos(x) + 2 x sin(x)

1 +
√

3, 1−
√

3
3
5

Maple provides useful shorthand ways to incorporate into a command the result of an
earlier command. The percent character % stands for the last result. Note that this
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means the last result that Maple calculated and not the previous result on the screen —
they can be different. Similarly you can use %% for the result before last (i.e. the second
last result), and %%% for the one before that (i.e. the third last result). You cannot go
further back than that using %. For example, the sequence of commands

diff(tan(x),x);

diff(%,x);
will give you the second derivative of tanx . Try it (and note that the derivative of tan x
is not expressed in exactly the way that you might have expected).

1.3.4 Context Sensitive Menus
Another way of using a previous result is provided by the context sensitive menus.

If you right-click on an object in the worksheet (such as a plot, or the result of a command)
a menu opens up allowing you to operate on that result. Exactly what you can do depends
on the result, which is why they are context sensitive. Several of the options have sub-
menus.

For example, with a plot the menu will allow you to change the plotting style, the
axes, the colours (if a 3-d plot) etc and to output the plot in one of several different forms.

If you have an expression, such as, say 1
3
x3 then right clicking on it will allow you to

choose to do several things to it, such as assign it to a name, differentiate or integrate it,
evaluate it or find its zeros.

With a matrix, you get the option to apply many commands from the LinearAlgebra

package (see section 2.12). Note that Maple uses the full name of the commands from
packages.

Using these menus can save a lot of effort. However, in a first year Maple Lab Test,
you need to make sure that you use typed Maple commands so that the marker can see
how you have used Maple commands to obtain the result.

1.3.5 Aborting Commands

If a command is taking too long and you want to stop it, click on the STOP icon (hand
in a red octagon). Unfortunately, this does not always work. If it does not, try typing
<Ctrl> -F4 (i.e. holding down the Ctrl key while pressing the key marked F4 on the
top row of the keyboard). If that does not work, you try to close the Maple window with
the button in the top right corner of the Maple window. NOTE that this may lose your
work — Maple may prompt you to save the worksheet before such an emergency stop,
but do not count on this. If you think a command might cause trouble, then save the
worksheet before pressing <Enter> (see section 1.4).

1.3.6 Inserting Comments
A comment in Maple (or in any computer program) is a statement which is not an

instruction to the computer. It is there to provide information for anyone who is reading
the file. There are two ways to insert a comment into a Maple worksheet.

1. Anything on a line after the symbol # is treated as a comment and ignored by Maple.
Some examples are given in the above exercise.

2. A new text group can be inserted after an output region by clicking on the box T
in the tool bar when the cursor is anywhere in the execution group containing the
output region. To get a new input region below a text group, click on the box [>

in the tool bar.
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1.3.7 Changing Maple Commands
Sometimes you will need to change a command that you have already entered. To do

so, move the Maple cursor to the place where you want to make a change by clicking
the left mouse button there (or by using the arrow keys). Then

the Delete key deletes the character to the right of the cursor

the Backspace key deletes the character to the left of the cursor

and you can insert new characters at the position of the cursor.

When you have changed a command and want to execute the changed command,
make sure that the cursor is (anywhere) on the line of that command and then press
<Enter>. The result of the changed command should appear on the screen, replacing
the previous result.

Note: If the command you changed uses % to refer to results of previous commands
then you will have to go back and re-execute those commands (by moving the cursor to
each of those command lines and pressing <Enter>) before you execute the command you
changed. This is because % refers to the result of the command most recently executed
by Maple which is NOT necessarily the one on the line above the cursor’s position.

Also, if the previous results of the command you changed were used in any subsequent
commands then these later commands will have to be executed again. To be safe, it is
best to press <Enter> on every command line which comes after any command line that
you have changed.

If you want to insert a whole new command among previous commands, move the
cursor to the execution group immediately above where you want the new command to
go. Then either click on the box [> in the tool bar or press <Ctrl>-J and a new line
with a [> prompt will appear. On this line you can type your new command or insert a
comment using one of the methods of section 1.3.6.

If you want to delete the whole region where the cursor is, press <Ctrl>-<Delete>.

Exercise If you have not already done so, start Maple. Enter the command

f := sin x;

You will get a message saying missing operator or ‘;‘ .
Correct the command to read

f := sin(x);

and then execute the corrected command. The result of this command is just an
echo of the command. Now enter a second command

diff(f,x);

Then go back and insert a new prompt just after the result of the command
f := sin(x). At this prompt, insert the comment “ Differentiate f: ”.
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1.4 Saving a Maple worksheet
A Maple worksheet can be saved and re-opened at a later time in much the same way

as other kinds of documents such as word processer documents or spreadsheets. Saving a
Maple worksheet preserves only what you see in the worksheet. When this worksheet is
re-opened, Maple will not remember and variables you may have defined, packages loaded
or the results of recently executed Maple commands. This will be become clearer once
you have used Maple.

A Maple worksheet can also be exported into other formats such as html, i. e. as a
webpage, or as a text file containing only the Maple commands.

It is strongly recommended that you save a Maple worksheet regularly while you are
using it.

There are two ways to save your worksheet. You can either click on the Save Icon
(picture of a floppy disk) or select either the Save or the Save As ... option from the
File menu. If you select Save or click the Save Icon and the active worksheet has a
name, it will be saved (as a worksheet) in a file with that name; if it has no name, you
get the Save As dialogue box. So you can save an updated version of the same session
in a file with the same name simply by clicking on the Save icon: If you wish to save it
with a new name, you will need to select the Save As ... from the File menu.

Selecting Save As ... will always bring up the Save As Dialogue Box. At the
bottom of the Save As Dialogue Box you will see a box which looks something similar to:

Maple Worksheet (.mw) ∇
If you are only using versions after Maple 9 you can ignore the options here; if you want to
be able to open your worksheet using Maple 8 or earlier, your should save it as a “Maple
Classic Worksheet (.mws)”.

Move the mouse pointer into the blank box beside the word File Name, click the left
mouse button in the box and type in the name of the file where you want to save the
worksheet. Then click on the word OK, or press <Enter>.

Notes:

1. If the filename has no (or the wrong) extension then the extension .mw will be placed
on the end.

2. If there is already a file with that name, you will be asked to confirm the name and
if you do the old file will be overwritten.

3. These processes will always save as a Maple Worksheet, even if you try to save to a
file with a different extension.

1.4.1 Exporting a Maple Input File
A Maple Input file contains only the Maple input regions (and text regions if any).

This can be opened or read in — see section 2.23.
To create one of these, select Export As... from the File menu. The Export As

Dialogue Box then appears. It is very similar to the Save As Dialogue Box, except that
at the bottom you will see a box which looks something similar to:

HTML (,html, .htm) ∇
If you now click on this box, a menu will appear giving you seven choices for the type
of file in which you can save your worksheet. The only one we mention here is the third:
Maple Input). For some of the others see section 3.6. Select the option that says Maple
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Input (.mpl) and then enter the name of the file in the File Name box. If the file does
not have the .mpl extension that designates a Maple Input file then Maple will add one.
If there is already a file with that name, you will be asked to confirm the name and if you
do the old file will be overwritten.

1.5 Maple On-line Help
Maple has built in help that can be accessed from the Help menu. A menu appears

looking like this:

Maple Help Ctrl-F1

Take a Tour of Maple

Quick Reference Ctrl-F2
...

Manuals, Dictionary, and more .

On the Web

About Maple. . .

If you select Maple Help from this menu, a new window will appear. In the right
hand section of this window is some text entitled Maple Resources. This window also
has several hyperlinks indicated by underlined text.

The left hand section of this window is the Help Browser, which will show the Maple
Help Navigator expanded as far as the help page visible in the right hand panel.

1.5.1 The Help Browser
To learn how to use the help browser, click on the Help and move your mouse down

to the line “Manuals, Dictionary, and more”. A second menu will appear; move over to it
and click on the option “Using the Help System”. The help browser will open and there
are several links to pages telling you how to use Maple’s help system, see figure 1.4.

Note: you can go back to a previous page in the Help Browser by clicking on the
large left pointing arrow in the top menu bar (it is “greyed out” in figure 1.4).

At the top of the left panel you will see a search box. You can use this to search for
help on a general topic (such as “integration”) or on a specific function. Below the search
box is a small drop down menu that allows you to be more specific in your search —
you can restrict to actual help pages on functions or have the search check through all of
Maple’s help pages, examples, tutorials, dictionary etc.

The results appear in the main part of the left panel, under two tabs. The “Search
Results” tab will be a list of the possible matches to your search, and the “Table of
Contents” is the Help Navigator. Clicking on one of the listed pages (under either tab)
will open that help page (or definition, or worksheet). The one at the top of the Search
Results list is automatically opened.

The Help Navigator shows how Maple’s help pages are linked together in a large tree,
and you can use this to find pages on similar functions to the one you serached for, which
can be useful if the search has not quite given you what you want.

You can also choose to search on “Topic” or “Text” with the buttons above the
search box. The difference between them is that “Text” looks though the pages for
the appearance of the search text, while “Topic” looks for pages about the search text.
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Figure 1.4: Maple Help Browser

For example, with “Text” selected, a search on “differentiation” gives you a lot of pages;
using “Topic” just two help pages and the dictionary definition page.

If you had selected a help page using the ? (see below) then the “Search Results” tab
is open, and lists all the results of a search on your input text.

You can change the relative width of the two panels in the help page by dragging the
left boundary of the right panel with the mouse.

1.5.2 Using the Results
The Help Navigator and Search Result panels use different icons to tell you about

the pages. An icon shaped like a folder tells you that there are subpages (or subfolders)
collected under that heading: clicking on a line with a folder icon opens up the subfolders
and pages.

A question mark designates a help page: clicking on that opens an actual help page in
the right hand side. A letter “D” in a yellow square links to a dictionary definition page.
Both of these open in the right panel of the Help Browser.

A “WS” in a light blue box is a Maple worksheet: this opens in a new window.
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The help pages start with a formal statement of the ‘syntax’ of the command (i.e. de-
tails of how to enter it). This may be hard to understand, but at the end of the entry
will be some examples of usage. Use the scroll bar to move through the entry until you
get to the examples.

Exercise Use a topic search to find the help entry for the integration command int

and read through it trying to understand it. Use the mouse to highlight one of the
example command lines from the end of this entry and press <Ctrl> -C to copy
the command. Then activate a Maple window and paste the command into it using
<Ctrl> -V . Press <Enter> and see that the result of the command agrees with
the result shown in the help window.

To close this Help window, open the File menu for the Help window and then select the
Close Help option.
An alternative to using the Topic tab in Maple’s Help window when you know the exact
word is to type a ? at a Maple prompt in a worksheet followed by the command name,
and then press <Enter>. For example,

?int
will open a Help window (if necessary) with the help on int in the right hand panel.

1.6 Maple and Moodle
In the First Year Moodle modules there are several lessons on Maple. These lessons

cover a large proportion of the material as chapter 2 of these notes, but as well as missing
out some detail, include a little extra material and examples.

Each First Year Course has access to the lessons appropriate for that course. To
see these lessons, follow the “Maple note, lessons, assessments” link in the “Computing
Component” section on the Moodle homepage of the Moodle module for your course.





Chapter 2

MAPLE COMMANDS AND LANGUAGE.

This chapter, which contains details of the Maple commands and language, is quite long
and looks formidable. However, most of the Maple commands are fairly obvious once you
get the hang of things. All you have to worry about is the exact syntax (way of writing
them), which you can get from Maple’s on-line help (see section 1.5).

The best way to use this chapter is first to glance through it to get an idea of what
Maple can do (actually it can do far more than what we have described here), bearing in
mind that many of the things in this chapter refer to mathematical ideas and processes
which may not yet have been covered in lectures (you may skip those bits until your
lecturer comes to them). You should particularly look at section 2.22 on common mistakes
in Maple: knowledge of these would probably give more than 50% of students an average
of 2 extra marks in the tests.

Later, when you are solving a specific problem, read through the relevant sections of
this chapter (and possibly look at some of the Moodle Learning Modules, see section 1.6)
before preparing a list of Maple commands to solve that problem. Then, when you are
entering these commands, use Appendix A (which contains a list of most of the useful
Maple commands) and Maple’s on-line help for their exact syntax.

2.1 Arithmetic.
The usual arithmetical operations are available in Maple and you should use the

following notation to enter them in commands.

addition +
subtraction -
multiplication *
division /
exponentiation ^

So a^b means a to the power b (i.e. ab ).
These follow the usual order of evaluation, i.e. anything in brackets, then powers, then

multiplication or division, then addition or subtraction.
If you want to use a different order then you will have to insert brackets ‘(’ and ‘)’ in

the appropriate places. For example -1^(1/2) means -(1^(1/2)) (i.e. −1 ), whereas
(-1)^(1/2) means

√
−1 (i.e. the imaginary number i , which is denoted I in Maple)

and -1^1/2 gives −1
2

.
Note that you cannot write a^b^c in Maple because it is imprecise (and grammatically

incorrect). Use either (a^b)^c or a^(b^c) as required. Also you cannot use two
operators next to one another as in a*-b — you should use a*(-b) instead.

There is another arithmetical operator, the ! symbol, which comes after a number
and denotes the factorial (so 5! = 1.2.3.4.5 = 120). Most calculators cannot find exact
factorials past about 12! and cannot even approximate them past about 70!. But on

13
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Maple you can easily find 1000! because Maple can handle integers of almost any size.
Try finding 1000!, but do not get carried away with calculating factorials because they get
very large very quickly and can easily lead you to exceed your time and memory limits.

Unlike most calculators and most computer programming languages, Maple does all
arithmetic EXACTLY, i.e. as rational numbers (fractions with numerator and denomina-
tor having as many digits as is necessary) or as surds or as roots of equations. The only
exception is when you deliberately enter numbers as decimals.

If you want to evaluate a fraction as a decimal number, use the command evalf
(‘evaluate as floating point’). This will normally display the answer to 10 significant
digits (although it uses more than 10 digits internally when doing its calculations). If you
want to use a different number of digits for all your displays of decimal numbers, use the
command Digits to set the required number. For example, enter

Digits := 50;
to tell Maple that you want all floating point results displayed to 50 significant digits. If
you only want to display one number to a different number of digits (without changing
the number of digits for all displays), you can include the number of digits in the evalf
command itself. For example,

evalf(1/17,50);
will evaluate 1/17 to 50 significant digits.

There are several ways to enter a decimal or ‘floating point’ number. For example,
67.2319 can be entered as 67.2319 or 0.672319*10^2 or 672319*10^(-4) etc, or in
the form Float(672319,-4) which stands for 672319 × 10−4 . Note that this always
has the form

Float(integer,integer);
There are limits to the size of the second integer (which specifies the exponent) and

the number of digits is governed by the value of the variable Digits.
Anything which is entered as a floating point number will stay as a floating point

number and will not be converted to a fraction unless you specifically ask Maple to
convert it into a fraction. To do that, use the convert command as in

convert(%,fraction);
Arithmetic done on floating point numbers will always give a floating point answer.

2.2 Variables: Assignment and Unassignment.
2.2.1 Assigning

You can assign any expression to a variable for further use, as was done in section 1.3
with the command

f := sin(x);
This assigns the current ‘value’ of the expression sin(x) to the variable f. If x is an
unknown, as was the case in Chapter 6, then f stands for the expression sinx and we
can, for example, differentiate this expression with respect to x . But if x had already
been assigned a value then that value will be used to assign a value to f. For example,
if x already had the value 0, then the above assignment would give f the value 0 (since
sin 0 = 0 ) and if x had the value a+2 then f would be given the value sin(a+2). Notice
that the use of the word ‘value’ is not being restricted just to numerical values. Possible
‘values’ which can be assigned to a variable include sets and lists and even equations.
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What we have been doing is called assigning a value to a variable and the general
format for doing it is

variable name := expression;

(Notice carefully that it is := and not just = that is being used here and there must
NOT be a space between the : and the = in :=.) After you have given an assignment
command, Maple will replace the named variable with its assigned value wherever that
variable name occurs in the future.

A variable that has not been assigned a value is an unassigned variable and can be
used just like any mathematical variable or unknown.

2.2.2 Variable Names
Variable names must start with a letter, or the underline character _, and the intial

letter can be followed by letters, digits and the underline character. Note that when Maple
creates an “arbitrary constant” it usually begins the name with the underline character,
so you should avoid starting your own variables with this character.

There is effectively no limit to the length of a name. Upper and lower case letters are
treated as different in names. Also, any string of characters surrounded by back-quotes
(i.e. ‘ which is not the same as the forward-quote ’ or the double-quote " ) is considered
a name, although such names are not useful as variables. Here are some examples

There are a number of variable names (such as Digits) which Maple uses for its own
purposes and you should not use these reserved names for your own variables. You
can get a list of most (but not all) of these reserved names by typing ? ininames at a
Maple prompt — the Help Browser will then open at the list of initially known names.

If Maple behaves unpredictably, you might try changing the names you have used for
variables, just in case you have used a reserved name.

Three names stand for constants that are important for us, namely,

Pi π = 3.141592 . . . (note capital P, small i)
I i =

√
−1 (note capital I)

infinity ∞ (used with limits)

Note that when Maple displays results it shows Pi as π and I as I and infinity as
∞ . It is legally possible for you to give the name pi (with a lower case p) to a variable,
but do not do it because it will cause confusion (unfortunately it will be shown as π in
Maple displays, but it will not evaluate to 3.141592 . . . ).
You may come across other named constants, like gamma which stands for Euler’s constant

γ = lim
n→∞

( n∑
k=1

1

k
− ln(n)

)
= 0.5772156649 . . . .

2.2.3 Unassigning
It will sometimes happen that after assigning a specific value to a variable, say

x := 2 (which we do not recommend: see below), you want to go back to using that
variable as an unspecified unknown. For example, you might want to evaluate the ex-
pression x^3-5*x+3 for x equal to 2 and then differentiate the expression with respect
to the unknown x.

This process is called unassigning a variable and you can do it by a command of the
form
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variablename:= ’variablename’
(For example, x := ’x’ to unassign the variable x.) Notice that both the quote symbols
here are forward quote ’ symbols.

If you want to unassign several variables at the same time, use the unassign com-
mand. For example

unassign(’a’,’b’,’fred’);
will unassign the three variables a, b and fred. The quotes are necessary here: otherwise
you will get an error message like

Error, (in unassign) cannot unassign ‘3’ (argument must be assignable)

because the names will be replaced by their values. The term argument that Maple uses
here refers to the terms inside the brackets.

If you wish to unassign all variables at once, restart your Maple session by typing the
command

restart;
or by clicking the Restart icon (shape of a loop with an arrow).

WARNINGS:

1. If you try to restart your Maple session by selecting New from the File menu in
Maple, you will get a new worksheet window. None of the variables you have
assigned will have values. Thus if you have assigned x the value of 2 in a worksheet
called ‘Untitled(1)’ and select New, you will get a new worksheet called ‘Untitled(2)’
where the value of x will be x. However, this behaviour can be altered (see 3.11.1
on changing the Kernel Mode).

2. If you define an expression f in terms of x at a time when a value has already been
assigned to x then a subsequent unassignment of x will NOT change f to being an
expression in the unknown x. For example, the sequence of commands

x := Pi/2;
f := sin(x);
x := ’x’;
diff(f,x);

will give the answer 0 because f is the constant 1, whereas the sequence

f := sin(x);
x := Pi/2;
x := ’x’;
diff(f,x);

will give the answer cos(x) .

3. You should NEVER assign values to commonly used variables such as x, because
you are likely to want to use them later as unknowns or you may go back to change
an earlier command in which one of these variables was used as an unknown. Note
that if you go back to change and re-execute a command then the value of any
variable in the command is the most recent value that you gave it in your Maple
session and this is NOT necessarily the value it had when you originally executed
the command that you are changing. You can get strange errors if you use assigned
variables as though they were unassigned. If you do assign to x or t or other one
letter variables, remember to unassign to them immediately after you have finished
using them with a value.
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2.3 Expressions and Functions.

It is important in Maple that you distinguish between expressions and functions.
For example, sin is a function (note the absence of any variable such as x ), whereas
x2 − x is an expression. Thus the command

y := x^2-x;

assigns to the (dependent) variable y the value of the expression x2 − x , involving the
(independent) variable x.

Note that if f is a function then f(x) is an expression which depends on x, and
expressions can be built up using functions in this way. For example, you can define y
to be the expression 1−

√
| sinx| by entering

y := 1 - sqrt( abs(sin(x)) );

Methods of defining new mathematical functions in Maple will be discussed later.
However, at this point, we WARN you that you CANNOT define a function f by a
command such as f(x) := ... because this DOES NOT make f a function.

2.3.1 Built-in Functions.

Although we will not discuss the creation of new functions until section 2.21, we will
be using functions in the next few sections, and so we will need some functions which have
already been defined. Maple has an enormous number of ‘initially-known’ mathematical
functions (i.e. ones which are already there when you start Maple). These include the
trigonometric functions

sin, cos, tan, csc (i.e. cosec), sec, cot

and their inverse functions

arcsin, arccos, arctan, arccsc, arcsec, arccot

and the hyperbolic functions

sinh, cosh, tanh, csch (i.e. cosech), sech, coth

and their inverse functions

arcsinh, arccosh, arctanh, arccsch, arcsech, arccoth
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as well as, for example:

Function Description Example

abs absolute value abs(-2);
sqrt square root sqrt(4);
ifactor factorise integers (can take a long time) ifactor(12);
igcd greatest common divisor of integers igcd(6,8);
ilcm least common multiple of integers ilcm(6,8);
max maximum of a sequence of numbers max(132,129,66,120);
min minimum of a sequence of numbers min(132,129,66,120);
binomial binomial coefficient binomial(4,2);
round round (up/down) to an integer round(3.5);
trunc truncate (towards zero) to an integer trunc(3.5);
floor round down to an integer floor(-3.1);
ceil round up to an integer ceil(-3.1);
frac fractional part frac(3.5);
exp exponential exp(1);
log or ln natural logarithm log( exp(2) );
log10 logarithm to base 10 log10(100);

For a complete list of the initially-known Maple functions, get help on inifcns
(either by typing ?inifcns or using the Maple Help Browser).

Not all Maple functions are initially-known. Some exist in packages and must be
loaded before you can use them. A package is a collection of functions which are loaded
using the command with. For example, most linear algebra functions are in the package
LinearAlgebra. They can be loaded using the command

with(LinearAlgebra):
Note the use of a colon here to supress unnecesary output — you should almost always
use a colon when loading a package. If you use a semi-colon you will get a (long) list of
all the functions in LinearAlgebra.

Once a package has been loaded, all the functions in it remain available until you
end your Maple session. If a function belongs to a package this will be shown in the
results of a help search. For example, when you get help on the function Rank in the
LinearAlgebra package, the help page is titled LinearAlgebra[Rank]

The main packages you will be using are student (for calculus), geom3d (for 3-
dimensional geometry) and LinearAlgebra (for linear algebra), which are described in
sections 2.9, 2.13.2 and 2.12 respectively.

Exercise Load the package student. Get the help entry for the function com-
pletesquare in this package. Use completesquare to write 4x2 + 12x as the
difference of two squares.

2.3.2 Evaluating a Function and Substituting in an Expression.
If a function f has already been defined (in particular, if f is one of Maple’s built-in

functions), you can use the usual notation f(x) for the value of f at x. For example,
sin(Pi) gives the value of sine at π and sqrt(a+2) stands for

√
a+ 2 .
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However, if f has been defined to be an expression in the variable x (for example by
f := x^2-x;), you CANNOT get the value of f when x is 3 by writing f(3) since f
is not a function. In this situation there are two methods which you can use to evaluate
f for a particular value of x, the first being the preferred one:

1. Use the command subs to substitute for x as in

subs(x=3,f);

Note that this does NOT change the value of x or f — it simply displays the value
that f would have if x were equal to 3. In this case x remains an unassigned variable
and f remains an expression dependent on x.

In general, the command

subs(expression1 = expression2, expression3);

will substitute expression2 for expression1 everywhere that expression1 appears
EXPLICITLY in expression3. For example,

subs(m=e/c^2,f=m*a);

gives the result f = ae/c2 .

Several substitutions can be done in the one command. For example,

subs(a=2*d,d=b/c,a*b*c);

will substitute 2*d for a and then substitute b/c for d, giving the result 2b2 .

2. Assign the desired value to x and then ask Maple to display f. For example, the
sequence of commands

f := x^2-x;
x := 3;
f;

will finally display the value 6, which is the value of x2 − x when x = 3 . If you
want the value of f at a second value of x, just assign the second value to x and
then display f again. If you want to return f to being an expression in the unknown
x then you will have to unassign x by one of the methods described in section 2.2.3.

2.3.3 Simplifying an Expression.
Maple often leaves an expression in a complicated form rather than in its ‘simplest’

form. To remedy this situation, Maple provides a number of procedures which you can
use in an attempt to get an expression into a form which suits you better. Nevertheless,
you have to bear in mind that factorising and simplifying expressions (other than very
easy ones such as those in high school) is a very difficult process, both for humans and
for the computer, and it is not always clear what ‘simplify’ means. Consequently, you
may have trouble getting Maple to produce what you consider to be the nicest form of
an expression. This is probably the most frustrating part of using a computer algebra
package.

The following is a list of some of the commands you can try if you want to ‘simplify’
an expression. The descriptions given here are only brief, and in each case you should use
Maple’s Help to find out more about these commands.
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normal tries to simplify expressions involving rational functions (i.e. ratios of polyno-
mials). In particular, it will cancel common factors in a rational function and will
bring sums of rational functions to a common denominator. For example,

normal( 1/(x-1) - 1/(x+1) );

gives the result
2

(x− 1)(x+ 1)
.

simplify tries to simplify any expression. For example

simplify( cos(x)^2+sin(x)^2 + 2^(5/2) );

will give you the result 1 + 4
√

2 .

This is more general than normal, and it may not do what you want for rational
functions. Also, you may sometimes have to tell Maple what type of simplification
you expect. For example, if x is positive (see section 2.18)

simplify( ln(x^2) + ln(x^3),ln );

will give you the answer 5 ln(x) : the option ln is telling Maple how to simplify.

radsimp will simplify radicals in an expression. It may not rationalise denominators
without using the ratdenom keyword.

expand is used to expand a product of sums of terms. For example,

expand( (x+1)^2 );

More ambitiously, you could try

expand( (x+a)^13*(2*x-3*b)^7 );

Also expand can do some expansions with other functions. For example,

expand( cos(a+b) );

gives the result cos(a) cos(b)− sin(a) sin(b) .

combine is almost the reverse of expand. It tries to combine terms into a single term
and applies the trig identities in the reverse direction. It also tries to combine sums
of unevaluated integrals into single integrals.

Sometimes you need to specify which type of combining is required. For example

combine( 3*ln(2)-2*ln(3), ln );

will produce ln(8
9
) .

There are other commands for manipulating polynomials, such as factor (which
factorises it into factors with rational coefficients), and collect (which collects coeffi-
cients of like powers). For more details of these, and other commands for manipulating
expressions, follow the links

Mathematics. . . Algebra. . . Expression Manipulation. . .

in the Maple Help Navigator.
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2.3.4 Defining functions with the arrow operator.
The arrow operator is used to define functions. For example, the function f which

acts as f(x) = x2 − x is defined by

f := x -> x^2-x;
Here we use an arrow (typed as a - immediately followed by >) to show that the

function replaces the (dummy) variable x by the expression x^2-x. Then the command

f(3);
will display 6, which is the value of f when x is equal to 3, and you can write f(2*a-1)

for the value of f when x is equal to 2a− 1 .
Note that the x which occurs in the definition of f is a dummy variable and has no

relation to any variable x which might occur anywhere else in your Maple session. It just
provides a way of specifying a formula for the function.

You can use f(x) in any situation where Maple will accept an expression in the
unknown x. You can also use f on its own to represent the function in some situations,
but you must make sure that the situation is one in which this applies. For example, you
can differentiate a function using the D operator (see section 2.4.2) or use a function to
define a Matrix or Vector (see section 2.10.4).

In MATH1231/1241 you will study functions of more than one variable. These can
also be defined with the arrow operator. For example,

d := (x,y,z) -> sqrt(x^2+y^2+z^2);

is a definition of the 3-dimensional distance function d(x, y, z) =
√
x2 + y2 + z2 .

Exercise Enter the above definition of the function f.
What happens when you now enter

f;
eval(f);

2.4 Elementary Calculus.
2.4.1 Limits

To find the limit of an expression as a variable tends to a value, use

limit(expression,variable=value);
For example, to find the limit of (sinx)/x as x→ 0 , type

limit( sin(x)/x, x=0 );
You can use infinity as a value if you want to find the limit as x→∞ .
For example, to find the limit of (1 + 1/x)x as x→∞ , type

limit( (1+1/x)^x, x=infinity );

You can ask for a one-sided limit by inserting left or right. For example, to get the
limit of 1/x as x→ 0+ , try using

limit( 1/x, x=0, right );
Note that the result is ∞ . In this case the lefthand limit gives the result −∞ and
the two-sided limit gives the result undefined.

2.4.2 First Derivatives
To differentiate an expression with respect to a variable, use

diff(expression,variable);
For example, to differentiate ex sinx2 with respect to x , you can enter
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y := exp(x)*sin(x^2); diff(y,x);

or just

diff( exp(x)*sin(x^2),x );

Remember that you should only differentiate with respect to an unassigned variable.
There are two ways to differentiate a function f:

1. Put the expression f(x) in the diff command. For example
diff( sin(x),x );

2. Use the operator D. In this case do not mention any variable in the command. For
example,
D(sqrt);

1

2 sqrt

It is often neater to use D because you can use it to differentiate and evaluate in one
step. For example, to find the derivative of sinx at x = π/2 you can use

D(sin)(Pi/2);
which is neater than the alternative

simplify( subs( x=Pi/2, diff(sin(x),x) ) );

You can use the D operator to differentiate a function that you have defined using the
arrow operator. For example, if you have made the definition

f := x -> x^2-x;
then

D(f);

will give x→ 2x− 1 because the derivative of x2 − x is 2x− 1 . You can evaluate this
function for a specific value just like any function, for example D(f)(1); returns 1, the
value of x2 − x at x = 1 .

2.4.3 Unevaluated Derivatives
If y is an unassigned variable, then the command

diff(y,x);
gives the answer 0 (since as far as Maple is concerned, y does not depend on x ). You
can force Maple consider y to be a function of x by using y(x) in place of y . For
example,

diff( y(x),x );

gives the answer
d

dx
y(x) . This will be needed when solving differential equations (see

section 2.15).

2.4.4 Higher Order Derivatives
To find the second derivative of sin 5x , you can use

diff( sin(5*x), x, x );
or alternatively

diff( sin(5*x), x$2 );

This second form is an example of the fact that (almost) anywhere in Maple you can use
expression $ number
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(with or without spaces before and after the $) to stand for the sequence consisting of
expression repeated number times. To differentiate an expression n times with respect
to x , you can enter

diff( expression,x$n );

To find a higher derivative, for example the third derivative, of a function f of one
variable using the D operator use

D[1,1,1](f);
This notation looks a little odd, but will make more sense once you learn about partial
derivatives in MATH1231/1241 (see 2.14).

2.4.5 Implicit Differentiation
If y related to x by an equation that defines y as a function of x , then Maple can

use implicit differentiation, to find the derivative of y with respect to x with the
Maple command implicitdiff.
For example, to find the slope of (a tangent to) the circle x2 + y2 = 1 , use

implicitdiff(x^2+y^2=1,y,x);

2.4.6 Maxima and Minima
To find the global minimum value over the whole real line for an expression in one

unknown x, use

minimize(expression);
Use maximize to find the global maximum.

You can also use these commands to find global maximum and minimum values for
expressions in several unknowns. For example, to find the smallest value (over all real
values of x and y ) of x2 + 2x+ y2 , try using

minimize( x^2 + 2*x + y^2 );

(You should get the answer −1 , as you can see by completing the square.)

2.4.7 Integration
To find an indefinite integral of an expression with respect to a variable, use

int(expression,variable);
For example,

f := x^2*sin(x);
int(f,x);

or just

int( x^2*sin(x),x );

Note that Maple does NOT show an arbitrary constant C in an indefinite integral.
If f is a function, then you need to put the expression f(x) in the int command,

not just f.

You can find a definite integral ∫ b

a

f(x) dx

by denoting the limits by the range x=a..b in the int command. For example,

int( sin(x), x=0..Pi );



24 CHAPTER 2. MAPLE COMMANDS AND LANGUAGE.

Remember to put exactly two full stops in the range. If you want to do an integral from
a to ∞ , just put infinity for the upper limit. For example, try

int( 1/(1+x^2), x=0..infinity );

Not all ‘elementary’ functions have an indefinite integral which can be expressed as an
‘elementary’ function. When Maple cannot find an elementary expression for an indefinite
integral, it may use non-elementary functions (not covered in first year mathematics) to
express its answer or, if it is really stuck, it will just display the integral expression
unchanged as its answer. As examples, try the following:

int( sin(x^2),x );
int( exp(-x^2),x );
int( exp(sin(x)),x );

If Maple will not give you an exact value for a definite integral, you can get an
approximate numerical value by means of evalf(%).

If you are using integration to find the area between two curves which intersect
several times, you might be tempted to ask Maple to integrate the absolute value of the
difference between the functions defining the two curves. Unfortunately, this does not
always work. You may have to find the points of intersection of the curves and integrate
appropriately over each interval between consecutive points of intersection.

2.4.8 Partial Fractions
The standard method for integrating a rational function is to expand the integrand

in partial fractions. You can expand a rational function (i.e. a polynomial divided by a
polynomial) in partial fractions by the command

convert(expression,parfrac,variable);
(The variable has to be specified because Maple can do expansions with respect to one
variable in expressions involving several unknowns.)

For example, try expanding 1/(x2 − 1) in partial fractions and then integrating it by

convert( 1/(x^2-1),parfrac,x );
int(%,x);

Notice that you get a different-looking (but equivalent) answer to what you would get by
simply saying

int( 1/(x^2-1),x );

2.5 Collections of Expressions, etc.
2.5.1 Sequences

A sequence in Maple is two or more expressions separated by commas, e.g.

2, 8, Pi, x^2, x*exp(x)

You can type a sequence and assign it to a variable, or the result of a Maple command
may be a sequence. For example, sequences are often produced by Maple when it solves
an equation that has more than one solution. If you try the following maple command
that finds the solutions to a cubic,

solve( x^3 - 4*x^2 + 5*x - 2 = 0 );

you will see that Maple responds with the sequence 1, 1, 2 , that is, some values separated
by commas. If you assign a sequence to a variable, the order of the values will be preserved.
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If you have a variable whose value is a sequence, take care that you do not use it as
the argument of a Maple function that expects a single object. For example, if you apply
evalf to a sequence with more than 2 values, you will get an error.

If you want to give Maple a sequence that can be described by a formula, use the
command seq. For example, the command

seq( n*(n+1), n=1..5);
generates the finite sequence 2, 6, 12, 20, 30 .

Sequences are used to construction several other types of objects in Maple, for example,
sets and lists. We will also use them to enter Vectors and Matrices (section 2.10).

2.5.2 Sets and Lists
A Maple list is a maple sequence enclosed in square brackets and a set is a sequence

enclosed in a curly brackets. For example, [1,2,3] is a list and {1,2,3} is a set.
Maple treats a list or a set as a single object.

The important differences between sets and lists are

• The order in which the things appear is not significant for sets but it is significant
for lists. Thus the sets {1,2,3} and {3,2,1} are treated as the same set but the
lists [1,2,3] and [3,2,1] are different. Of course the contents of a set will be
printed in some particular order when Maple displays it, but this order is decided by
Maple and may not be the same as the order you entered. Maple keeps the order of
display of a set constant in any one session, but if you enter the same set in another
Maple session then the order of display may be different .

• Repetition of an item in a set is ignored, but this is not so for lists. Thus the sets
{1,2,3} and {1,2,3,1} are treated as the same set but the lists [1,2,3] and
[1,2,3,1] are different.

Note that the things in a set or list do not have to be numbers. For example, you could
define a list

a := [ 1, x, x^2+x+1, y^2+y=0, {1, 2, 3} ];
in which the entries are a number, an variable, an expression, an equation and a set.

2.5.3 Converting Structures
You can turn a sequence into a set or a list by putting it inside square or curly brackets

respectively. For example, try

Sq := 1,2;
St := {Sq};
L := [Sq];

and check that the values assigned to the variables St and L are the set {1,2} and the
list [1,2] respectively. This is useful because you cannot apply evalf to a sequence but
you can apply it to a list.

To convert a set into a list or vice versa, use the command convert. For example
convert( St,list );

gives a list with the same value as L. This is useful if the things in the set are numbers
and you want to sort them into numerical order. You cannot apply the command sort
in section 2.5.5 to a set or a sequence, but you can apply it to a list.

To convert a set or list into a sequence, use the command op. For example
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op(L);
gives a sequence with the same values as Sq. This is useful if you want to add someting
at the end of the list. For example, you can change the value of the variable L from the
list [1,2] to the list [1,2,3] by

L := [ op(L), 3 ];

The command op will also convert any expression into a sequence. This is because
algebraically any expression consists of an operator acting on a sequence of ‘parts’ or
operands, and op extracts the sequence of those operands. For example, the command

op(6*(x+y)/z);
gives the sequence 6, x + y , 1/z since 6(x + y)/z is the product of 6, (x + y) and
1/z . There is a problem in that it is not always easy to tell what Maple will regard as
the operator. For example, Maple regards 1/z as the power of z to the -1, and so

op(1/z);
gives the sequence z , −1 .

2.5.4 Selecting Operands
The command op is actually quite a powerful general procedure for selecting operands

in many contexts, but its full description is a bit too advanced for inclusion here (for full
details, use Maple’s Help). One use is that if n has a positive integer value then

op(n,expression);
selects the nth operand of the expression. For example, the command

op(2,1/z);
gives −1 (see the example above).

In special cases there are synonyms for op such as:

numer and denom give the numerator and denominator of a quotient expression.
For example,

numer( sin(x)/(1+cos(x)) );

gives the result sin(x) .

coeff picks out the coefficient of a specified power of a variable in a polynomial.
For example,

coeff( polynomial,x,5 );

gives you the coefficient of x^5 in the polynomial. (If like powers have not been
gathered together in the polynomial, use collect first.)

lhs and rhs pick out the lefthand and righthand sides of an equation.

2.5.5 Sorting
If the entries in a list have values which are real numbers , you can use the command

sort to sort the entries in the list into increasing numerical order, but you CANNOT do
this for a sequence or a set . For example

sort([-1,2,-4,9]);
gives the result [−4,−1, 2, 9] .
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sort can also be used to put the terms of a polynomial into decreasing power order.
For example,

sort(1+x+x^6-x^3);

will give the result x6 − x3 + x+ 1 .

This command is useful for selecting one of the roots of an equation whose roots are
all real. For example, if you want to select the second smallest root of the equation
x4 − 6x3 − 33x2 + 46x+ 72 = 0 , the best way to do it is

soln := solve( x^4 - 6*x^3 - 33*x^2 + 46*x + 72 = 0 );
soln := [soln]; # to convert to a list
soln := sort(soln);
soln[2];

However, if some of the roots are not real, they may not be able to be sorted by size.

2.5.6 Substituting into a Structure
If S is a set or list whose entries are expressions involving a variable x, then you can

use the command

subs(x=2, S)
to substitute the value 2 for x in S.

The Maple command subs can be used in a similar way with Vectors and Matrices
that will be discussed in section 2.10.

2.5.7 Applying Functions to each Entry of a Structure
You cannot generally apply a function to each entry of a structure S just by giving a

command of the form function(S). To do this, use map in the form map(function, S).
For example, to apply the function sin to each entry of a set S, use

map(sin, S);
This will replace each entry of the set S by its sine. Similarly, if L is a list whose entries
are expressions involving numbers, then you can apply evalf to each entry of L using
map

map(evalf, L);
to evaluate all the entries as floating point numbers. For example

L := [Pi, sqrt(2), sin(1)]:
map(evalf, L);

yields [ 3.141592654 1.414213562 .8414709848 ] . Some Maple functions automatically
are ‘mapped’ to the entries of a structure and evalf is one such function. So the same
result could have been achieved by evalf(L).

The Maple command map can be used in a similar way with Vectors and Matrices
that will be discussed in section 2.10.

2.5.8 Sums and Products
If f is an expression in the unknown k, you can use the command

sum(f,k=m..n);
to ask Maple to evaluate

n∑
k=m

f(k).



28 CHAPTER 2. MAPLE COMMANDS AND LANGUAGE.

To get a sum to infinity, use infinity as the upper limit. For example, try

sum(1/k^2,k=1..infinity);

If f is a function, you will need to write f(k) in the command (not just f).

You can use similar methods to evaluate products such as

n∏
k=m

f(k).

Just use product instead of sum.

Note that there will be many cases where Maple cannot find a simple expression for
the answer and it may just return your question as its answer. For example, try asking
Maple to find

∞∑
k=2

1

k2 ln k
.

Maple also has the command add and mul, which should be used in certain situations
in place of sum and product — see Maple’s help pages.

2.6 Equations.
In Maple an expression of the form

leftside = rightside ;
is an equation. Note that in this case the = symbol is used alone and not with the :
which appears in assignment commands. Make sure that you do not confuse equations
with assignment commands.

Maple allows you to perform various operations on equations. You can add two equa-
tions, or multiply an equation by a constant, or add a constant to it (i.e. to both sides of
it). You can use this to solve simple simultaneous equations. For example,

> e1 := 2*x+y=5: # e1 is the first equation
> e2 := x-y=4: # e2 is the second equation
> e1+e2; # add the equations

3x = 9

> %/3; # divide result by 3

x = 3

> 2*e2-e1; # twice 2nd eqn minus 1st

−3y = 3

> %/(-3); # divide result by -3

y = −1

> e2+(y=y); # add y to both sides of e2

x = 4 + y
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2.6.1 Solving Equations.
Maple provides two basic commands for solving equations: solve and fsolve.

In general, neither of these procedures tries to find all solutions to an equation. However,
both of them will try to find all real solutions to a polynomial equation.

If you give one of these solvers an expression instead of an equation, it will assume
that you want to solve the equation expression = 0 .

Using solve
This tries to find exact solutions to an equation or set of equations. For example, to

solve 3x+ 4 = 5x , use

solve( 3*x+4=5*x );
which gives the answer 2.
If the equation involves more than one variable, you will have to tell Maple which

variable to solve for. For example,

solve( a*x^2+b*x+c, x );

Notice that in this case we gave solve an expression rather than an equation and Maple
will assume that we want to solve the equation ax2 + bx+ c = 0 .

If solve finds more than one solution then you may want to select a particular one.
This will be discussed later in section 2.5.

To solve more than one equation in more than one variable, use

solve( [eqn1,eqn2,...], [var1,var2, . . .] );
Note the brackets [ ] which tell Maple that we are giving it a list of equations and a list
of variables. You can also use braces ({ }) to give a set of equations etc (which is what
we do below). See section 2.5 for more detail on sets and lists.

For example, the following is a piece of Maple which solves a pair of equations
(in fact, the ones we solved above) and then checks the results by substituting them
back into the equations.

> e1 := 2*x+y = 5:
> e2 := x-y = 4:
> solve( {e1,e2}, {x,y} );

{x = 3, y = −1}

> assign(%):
> x; y;

3

−1

> e1; e2;
5 = 5

4 = 4

Notice the use of the procedure assign. It takes the solution values from solve and
assigns them to the appropriate variables. The results from the last command show that
when these values have been assigned to the variables, the values of the two sides of each
equation are the same, so the equations are satisfied. Do not forget to unassign x and y
after these steps, in case you want to use them again as unknowns in other equations.
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When using solve, you will often get answers involving expressions like

RootOf(_Z5 − 5_Z − 1)

It is not possible to solve the equation z5 − 5z − 1 = 0 in rational numbers or radicals,
so Maple just says the answer is a general root of this equation. The variable _Z is just
a dummy variable, introduced by Maple to state the formula for the polynomial. You
should not use _Z yourself.

You can assign this general root to a variable and do calculations with this variable
as though it were a number, but remember that it really stands for more than one value
(in the above example, 5 values).

If you have done some calculations involving a RootOf expression and want to see all
the corresponding answers, use the procedure allvalues. This will produce a sequence
(see section 2.5) whose entries are the values that you want. If the roots can be expressed
in a simple form, this sequence will be useful. Otherwise (as in the case of the solutions
of z5− 5z− 1 = 0 ), you will simply be given all the answers in symbolic form. This may
be overcome by using evalf to get the approximate answers. For example, try entering

alpha := 2 + 3*RootOf(_Z^5-5*_Z-1);
allvalues(alpha):
map(evalf,[%]);

Using fsolve
This tries to find approximate floating point solutions to an equation or set of equations.

Note that in general fsolve only finds one solution even when many solutions exist. For
example, the command

fsolve( tan(sin(x))=1, x );

will only give you the solution .9033391108 (though there are obviously many other
solutions — as can be seen by plotting the graph of tan(sinx) ).

If you give fsolve a range of values for the variable, it will try to find a solution in
that range. For example, the command

fsolve( tan(sin(x))=1, x, 2..3 );

will give you another solution 2.238253543 .
Sometimes fsolve may not find any solution even though one exists. This usually

happens because fsolve is using a method of successive approximations and none of the
starting points which it tried has produced a convergent sequence of approximations. In
this case, try suggesting a range of values within which you know that there is a solution
(from something like the Intermediate Value Theorem or by plotting the graph). This
gives Maple a better idea of values it should try as starting points for its approximations.

Remember that for a polynomial equation, fsolve will try to find all real solutions
(or all real solutions in a specified range). For example, the command

fsolve( x^3-3*x^2+2*x, x, -1..3/2 );

will give you the solutions 0. and 1.000000000 , but not x = 2.000000000 .
If you want fsolve to find all complex (including real) roots of a polynomial, insert

the keyword complex. For example,

fsolve( x^2-2*x+2, x, complex );

Maple provides other solvers for special situations, for example dsolve for differential
equations and rsolve for recurrence relations — see sections 2.15 and 2.17.
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2.7 Complex Numbers.
In Maple, complex arithmetic is normally done automatically with I standing for√
−1 (for example, if you square I you will get −1 , not I2 ). But Maple does not always

automatically evaluate an expression involving complex numbers. For example, it may
leave an expression as the product of some complex numbers or as an expression involving
a root of a complex number. In these cases, apply the function evalc to force Maple to
evaluate as a complex number.

For example, Maple will leave
(-2*I)^(1/2);

as
√
−2I until you apply evalc. Applying evalc gives the result 1 − I . Note that

evalc does not give you both the square roots of -2*I — it only gives the ‘principal
value’ of the root. If you want both the roots, use

solve( z^2=-2*I );
You will find that evalc often gives its results in terms of trigonometric functions

and this may make the results hard to read. You may find the approximate floating point
form more readable. To get this, apply evalf (with or without evalc).

When solving for the roots of a polynomial with real or complex coefficients, the result
may be a sequence of complex numbers or a RootOf expression (which gives a sequence
of complex numbers when you apply allvalues, as explained above). These sequences
are often in a very messy form and you need to convert them to something simpler using
evalc and/or evalf. Note carefully that you must enclose a sequence of results in square
brackets before you apply evalc nor evalf to it. (The reasons for this will be explained
in section 2.5).

For example, to find the cube roots of the complex number 2 + i , we would use

solve( z^3=2+I );
This produces a sequence of 3 complex numbers expressed in a messy form. If you want
these exact values to now be expressed in the standard a+ ib form, use

evalc([%]);
This will give an even bigger mess (though exact and in the standard form), so you will
probably want to see the approximate floating point values. To get these, use

evalf([%]);
OR get them directly with

fsolve( z^3=2+I, z, complex );
(as explained in the section 2.6.1).

Maple provides a number of built-in mathematical functions which can be used with
complex arguments. These include

Re(z) real part
Im(z) imaginary part
conjugate(z) conjugate
abs(z) complex modulus
argument(z) argument (in range −π < arg ≤ π)

2.8 Plotting.
Maple has the ability to plot data points and graphs and parametrically defined curves

and curves in polar coordinates. It can also do 2-dimensional representations of surfaces
in R3 .
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The simplest way to get Maple to draw a graph is a using a command like

plot(expression,variable=start..end);
In this case Maple will decide the appropriate vertical scale. If you want to specify
minimum and maximum values on the vertical scale, use

plot(expression,variable=start..end, min..max);
Note that there must be exactly TWO full stops between start and end and between min
and max . (This notation is used whenever you refer to a range of values in Maple.)

This command will plot the expression for values of the variable over the range from
the start value to the end value and the range on the vertical axis is restricted to the
range from the min value to the max value. The expression should normally depend on
the variable and the variable must be an unassigned variable (otherwise you will only get
an error message, an empty plot or a straight line).

Figure 2.1: Plot of tanx

For example, figure 2.1 was produced using

plot(tan(x), x=0..2*Pi, -10..10);
to plot tanx from 0 to 2π with the vertical scale restricted to [−10, 10] .

The plot will appear in the output region linked to this command (be patient — it
may take a little time to appear). Note what Maple has done with the discontinuities at
π/2 and 3π/2 .

The appearance of this plot can be changed. Click anywhere on the graph and you
will notice two things will happen:

• a window will appear around the graph with ‘markers’ on the edges and vertices:
these can be used to re-size this window in the usual way;

• the context bar (just above the worksheet — see section 1.2) will be replaced by
a new set of buttons (use the Tool Tips from the Options submenu of Maple’s
Tools menu, see 3.11.1, to find out about these), with a box on the extreme left
showing the approximate coordinates of the point where you clicked: this is useful
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for getting approximate coordinates for a point of intersection of two graphs or the
intercepts of a graph.

Note: As Maple scales each axis differently, it may give a misleading impression of the
graph. To get a truer scale, add the option scaling=CONSTRAINED at the end of the
plot command, or click on the button 1:1 in the context bar.

If you want to compare plots, you can have two or more plot windows open at the
same time or you can plot more than one curve on the same set of axes. For example, to
plot y = f(x) , y = g(x) and y = h(x) simultaneously on the same axes use

plot( {fx,gx,hx}, x=start ..end);

when fx, gx and hx are expressions depending on x, or

plot( {f(x),g(x),h(x)}, x=start ..end);

when f, g and h are functions.
Note the use of curly brackets (braces) { } here.

The plot command offers options which control the number of points at which the
function is plotted, the number of tick marks on the axes and the placing of titles on the
graph. Read the help page on plot to find out about these options.

To get a printout of a Maple plot, right click while pointing at the graph. A menu will
pop up: select the option Export and the option “Encapsulted PostScript”. A dialogue
box will open and you will have to enter the name of an appropriate file (for example
temp.eps) and then click “Save”. This will create a new file which you can find and
view in the file manager. The file manager will open this file in a postscript viewer and
you can print it using this viewer. See the lab notes for details on using file manager and
printing.

2.8.1 Plotting Piecewise-defined Functions
If you wish to plot an expression which is defined in a piecewise way, then use the Maple

command piecewise. For example, to plot the expression fx which is mathematically

fx =


0 if x < 0;
x2 if 0 ≤ x < 1;
2x− 1 if x ≥ 1.

you can use the command:

fx := piecewise( x<0,0, x<1,x^2, 2*x-1 ):

For example the value of fx will be 0 when x = −1 , 1/4 when x = 1/2 , and 5 when
x = 3 . Note that the ranges are stated before the expressions, that an earlier range
(x < 0 ) takes precedence over a later one (x < 1 ) and the last range (x ≥ 1 ) can be left
out. An alternate way of doing this is given in section 2.21.1.

Now to plot this for x between −5 and 5 , simply type

plot(fx, x=-5..5);

2.8.2 Plotting Data Points
To plot x - y data points defined by two lists

x := [x1,x2, . . .,xn] y := [y1,y2, . . .,yn]
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you should first construct a list of the coordinate pairs [x1 ,y1 ], [x2 ,y2 ], . . . , [xn,yn]
and then plot this list. (For details on lists, see section 2.5.) For example,

datapoints := [ [1,sin(1)], [2,sin(2)], [3,sin(3)], [4,sin(4)],
[5,sin(5)], [6,sin(6)], [7,sin(7)], [8,sin(8)] ];

or (see section 2.5 for the seq command)

datapoints := [seq([i,sin(i)],i=1..8)];

Note the use of square brackets here. The square brackets in [1,sin(1)] etc. are
to indicate the coordinates of a point in the x, y -plane (an ordered pair of numbers —
i.e. a list with two members). The outermost square brackets are to make the sequence
of coordinate pairs into a list.

When you have created the list of coordinate pairs, execute the plot by

plot(datapoints);

2.8.3 Parametric Plots
To plot a curve defined by

(x, y) = (ft, gt)

for t from a to b when ft and gt are expressions depending on t, use

plot( [ft,gt,t=a..b] );
Note the use of square brackets [ ] here. For example, try plotting a cusp with

plot( [t^2,t^3,t=-5..5] );

or try plotting a circle with

plot( [cos(t),sin(t),t=0..2*Pi] );

where cos(t) and sin(t) are expressions made up using the functions cos and sin .

2.8.4 Polar and Implicit Plots
The package plots provides special plotting procedures. Once you have loaded the

package by doing

with(plots):
you can use polarplot for polar curves and implicitplot for implictly defined curves.

Figure 2.2 is a plot of the the cardioid r = 1− cos θ for θ from 0 to 2π done using
the command

polarplot(1-cos(t),t=0..2*Pi);
For convenience, we have used t as the name for the variable representing θ — we do
not have to name it theta.

You can plot the same curve in a parametric format as

polarplot( [1-cos(t),t,t=0..2*Pi] );
and you can plot several polar curves on the same diagram by using curly brackets in the
same way as for the command plot.

Try plotting the implicitly defined ellipse x2 + y2/4 = 1 to true scale by

implicitplot(x^2+y^2/4=1,x=-3..3,y=-3..3,scaling=CONSTRAINED);

where the scaling=CONSTRAINED forces Maple to use the same scale on the two axes
(otherwise the graph looks like a circle).
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Figure 2.2: Plot of cardioid with polarplot

2.8.5 3-D plots
Maple provides lots of nice features for 3-D plots. For example, you can change the

plot style, the style and scale of the axes and the point from which the surface is viewed.
If you click on the graph, you will get a window and new buttons in the context bar (in a
similar way to 2-dimensional plots). If you continue to hold down the left mouse button
(while pointing the mouse at the plot), and move the mouse around, the orientation will
change so that you can get a different perspective on the plot.

3-D plotting is not required for first year Mathematics subjects in any serious way, and
we do not give the details here. The command for 3-D plots is plot3d and you should
see Maple’s Help if you wish to use it.

2.9 The student Calculus Package.
One of the aims of the student calculus package is to help you to practice the sort

of methods which are needed to find integrals when you do not have access to software
like Maple. When you use commands from this package, you can specify the method of
integration and Maple just does the calculations.

The package also contains other procedures of interest to students of calculus (e.g
Riemann sums, Simpson’s Rule, maxima and minima). Some of these are described in
this section and you can use Maple’s Help to find out about the others.

As mentioned in section 2.3.1, the procedures described in this section will not work
unless you have loaded the student package by typing

with(student):

2.9.1 Inert procedures.
If you are trying to practice integration by substitution then you do not want Maple

to go ahead and carry out the integration as soon as you enter the integral — you want
Maple to transform it into another integral. Maple provides the command Int (note
the upper case I) to allow you to enter an integral without having Maple go ahead and
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evaluate it. This is an example of what is called an inert procedure. Maple also provides
the inert procedures Diff, Limit, Sum and Product for entering derivatives, limits,
sums and products.

After you have entered an expression with one of these commands and applied various
procedures to the expression, you can finally evaluate it with the command value, as in

value(%);
Note that value only works with Int, Diff, Limit, Sum and Product.

2.9.2 Change of Variable
To change the variable in an integral (i.e. to apply the method of integration by

substitution) use the command changevar. The general form of this command is

changevar(s,F,u);
where

u is the new variable which is being introduced

s is an equation of the mathematical form h(x) = g(u) which implicitly or explicitly
defines the old variable x in terms of the new variable u

F is an expression like Int(f,x) or Int(f,x=a..b) when f is an expression in x;
or Int(f(x),x) or Int(f(x),x=a..b) when f is a function.

The result of the command is an expression for F with the variable changed. For example,
changevar( 1+x^2=u, Int(x/(1+x^2),x=a..b), u );∫ 1+b2

1+a2

1

2u
du.

If you use value to evaluate an indefinite integral in terms of u then you cannot
always use changevar in the reverse direction to get the answer in terms of x. You may
have to use subs to substitute for u in terms of x (see section 2.3.2).

2.9.3 Integration by Parts
This is integration by means of the formula∫

u dv = uv −
∫
v du.

The general form of the command is

intparts(F,u);
where u is the expression which is to play the role of u in the above formula and F is of
the form Int(u*expression,x).

For example, to integrate x3 sinx with u = x3 try
intparts( Int(x^3*sin(x),x), x^3 );

2.9.4 Riemann Sums and Simpson’s Rule
The student package offers you the opportunity to calculate some Riemann sums

and get pictures showing the graph of the integrand together with the rectangles whose
areas make up the Riemann sum. It can also show sums corresponding to approximations
given by Simpson’s Rule.

The command

rightsum(expresssion,x=a..b,n);
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will give you a summation expression for the Riemann sum obtained by dividing the
interval from a to b into n equal subintervals and erecting on each subinterval a rectangle
whose height is the value of expression at the righthand end of the subinterval. If you use
rightbox instead of rightsum, you get the diagram for the same Riemann sum.

There are corresponding commands leftsum and leftbox which use values at the
lefthand ends of the subintervals and middlesum and middlebox which use values in
the middle of the subintervals.

The command

simpson(expression,x=a..b,n);
gives the summation expression which would arise if you used Simpson’s Rule to get an
approximate value for the integral of expression from a to b.

The expressions given by the comands rightsum, leftsum, middlesum and simp-
son are not numerical values — they are in the form of a sum such as

1

10

(
10∑
i=1

(
1

100
i2
))

.

To see the actual value of the summation, apply value. This will, in general, give an
algebraic expression and you may need to use evalf in order to get a meaningful answer.
If the value of n is large then value will produce an enormous amount of messy output,
so it is best to combine all these procedures into one command by entering

evalf( value(rightsum(f(x),x=a..b,n)) );
(or alternatively, use a colon at the end of the value command line).

2.10 Vectors and Matrices
2.10.1 Vectors.

Maple uses a capital V for vectors when you use the LinearAlgebra package. (Be
careful not to use vector with a small ‘v’. You will not get an error as this is used by an
older package called linalg, but things may not work as you expect.)

You create Vectors by using the Vector procedure, or more easily by angle brackets
(the < and > signs):

<sequence>;
where sequence is a sequence of expressions (which can be numbers). For example, the
command

v := < 1,-5,4 >;
assigns to the variable v a value which is a 3-dimensional Vector with components 1, −5
and 4 (in that order). Alternatively, one could use

v := Vector( [ 1,-5,4 ] );

You can also use fuctions to define Vectors. For example, to create a Vector in R3

whose entries are 1,4 and 9 respectively, use
Vector(3, i -> i^2);

2.10.2 Matrices
Maple uses a capital M for a matrix in the LinearAlgebra package. (Be careful

not to use matrix with a small ‘m’. You will not get an error as this is used by an older
package called linalg, but things may not work as you expect.)
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You create a Matrix using pairs of angle brackets (or the Matrix procedure). You
enclose the columns of the Matrix as a collection of Vectors, separated by vertical lines
| and linked together with an outer set of angle brackets. For example, you can assign
the matrix 1 2 3

3 −1 5
3 −2 4


to the variable A with the command

A := < <1,3,3> | <2,-1,-2> | < 3,5,4> >;

Note the outer set of angle brackets < > which make the object into a Matrix.
These outer brackets must be there even if the matrix only has one column, as in

A := < <1,2,3> >;
Note that Maple does NOT regard a Vector as the same thing as a Matrix with one
column, but the differences will probably not be relevant to you in first year.

An alternative way to enter matrices is by rows rather than columns: all you need to
do is “swap the commas and bars around”. So the prevous matrix can be defined by

A := < <1|2|3> , < 3|-1|5> , <3|-2|-4> >;
However, it is better to think of matrices in columns rather than rows so the ‘collection of
columns’ method is preferable. It is also easier to type commas rather than the vertical
bars, of course, and there are fewer bars in the collection of columns method.

You can also create a Matrix using a function that tells Maple how to calculate each
entry. For a Matrix you need a function of two variables (and to give two dimensions),
for example,

Matrix(3,2, (i,j) -> i^2+j^3);

It is conventional in mathematics to use a single capital letter to denote a matrix, but
Matrix names in Maple do not have to follow this convention — they could be a lower
case letter or any valid Maple name. But remember that A and a are not the same name.
Also be warned that some letters (such as D) are reserved.

Note that the default behaviour of Maple, for both Vectors and Matrices, is to display
a placeholder when any dimension of a Vector or Matrix is larger than 10. For example,
try

Vector(11, i -> i^3);
To see how to alter this behaviour look up the Maple help page for interface.

2.10.3 Selecting Components of Vectors and Matrices
If the value of A is a Matrix, you can use the notation A[i,j] to refer to the entry in

the ith row and jth column of A. For example, if the value of A is1 2 3
3 −1 5
3 −2 4


then A[3,2] has the value -2.

Similarly, if the value of a variable v is a Vector, you can use v[n] to refer to its nth
entry. For example, if (the list) v has been assigned a value by
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v := [1,2,-4,9];
then v[3] will have the value −4 because the third entry in the list is −4 . Note that
the same notation also works for lists.

You can use these notations in commands to change the value of entries. For example,
the commands

v[2] := 12: A[2,1] := 13:
will assign the value 12 to the second entry of the list v and the value 13 to the entry in
the second row and first column of the Matrix A.

You can do the same thing with a set, but this is dangerous because the order of
entries in a set is not fixed, so you cannot be sure which entry Maple will regard as being
the nth entry.

2.10.4 Manipulating Vectors and Matrices
The last section shows how to create and display Vectors and Matrices. However, we

cannot do any useful linear algebra without first loading the LinearAlgebra package,
which provides many procedures for dealing with Vectors, Matrices and linear equations.
In these Notes we will only give an outline of some of the basic procedures. To find out
more about these and other procedures available in LinearAlgebra, use Maple’s Help.

To use the procedures in this package, it is easiest to first load it with the command

with(LinearAlgebra):
Note the use of the colon here, which supresses the (very long) list of new funcitons in
LinearAlgebra. You can use a command from this package directly by giving its full
name: you do this by adding LinearAlgebra:- to the start of the command. This is
what Maple will do if you operate with the context sensitive menus (see section 1.3.4).

The package LinearAlgebra also allows you to enter a diagonal matrix (i.e. a matrix
A with aij = 0 for i 6= j ) by using DiagonalMatrix. You can use either a list or a
Vector as the argument of DiagonalMatrix. For example,

A := DiagonalMatrix([1,2]);

A :=

[
1 0
0 2

]
.

There is the useful command IdentityMatrix for creating (of course) identity matrices.
For example, the 6× 6 identity matrix is

id6 := IdentityMatrix(6);

Also, new Matrices can be constructed by combining Vectors and/or Matrices. If we
have Vectors, say v1, v2 and v3, then we can form a Matrix which has these vectors as
columns by using the angle brackets and vertical bars

< v1 | v2 | v3 >;
Similarly, if we have matrices A, B and C of appropriate sizes we can combine them

side by side (called augmenting) into a large matrix by using

< A | B | C > ;
or one on top of the other (called stacking) by using

< A , B , C >;

Conversely, you can extract vectors from matrices by using Column(A,i) to create a
Vector whose components are the entries in the ith column of the Matrix A. For example,
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v := Column(A,2);
We also have Row for rows — but this creates a row Vector, which is not something
we’ll be dealing with.

If you use a range (for example 2..3) you can extract more than one column (as a
sequence).

Note that the things created by Column (and Row) are Vectors (or sequences of
Vectors) and not Matrices

Another procedure which selects parts of matrices is SubMatrix. The command

SubMatrix( A, a..b, c..d );
(where a..b and c..d are ranges of positive integers) produces a smaller Matrix whose
entries are the values of A[i,j] for a≤i≤b and c≤j≤d, arranged in the same relative
positions as they had in A.

You can also use SubMatrix in the form

SubMatrix( A, [1,4..6], [2..4] );
to get the submatrix whose entries are the values of A[i,j] for i in the list [1,4,5,6]
and j in the list [2,3,4].

Maple also let’s you define Vectors and Matrices using an indexing function. If f is
a function that takes one argument, Vector(5, f) gives a vector with the 5 entries,
f(1) , f(2) , f(3) , f(4) , f(5) . Similarly, if g is a function that takes two arguments,
Matrix(2, 3, g) produces a Matrix with 2 rows and 3 columns in which the element

in the i th row and j th column is given by g(i, j) . See section 2.21 for examples.

2.11 Gaussian Elimination.
The LinearAlgebra package provides the procedure RowOperation which allows

you to solve systems of simultaneous linear equations by going step by step through the
steps of Gaussian elimination. The one procedure will do different things, depending on
what arguments you give it. So:

< A | b> augment Matrix A by Vector b to give (A|b)
RowOperation(A,[i,j]) swap rows i and j in A
RowOperation(A,i,m) multiply row i of A by the value of m
RowOperation(A,[i,j],m) replace row i with row i + (row j)*m in A

i.e. add m times row j to row i
(NOTE THE ORDER CAREFULLY)

Note that the Matrices produced by these procedures are NOT assigned as new values
for the original variable A (unless you specifically instruct Maple to do that by adding the
option inplace=true, see the help page). Usually you will assign the resulting matrix
to a new variable (as in the following example) OR just allow Maple to display the result
and use % to refer to it in your next command.

Example

If you want to apply Gaussian elimination to the augmented matrix

(A|b) =

0 1 2 1
2 −1 −2 1
1 2 4 0

∣∣∣∣∣∣
1
−1
5


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then you could proceed as follows. (Note that some of the command lines end in a colon.
This is to save space by suppressing display of the result.)

> with(LinearAlgebra):
> A := < <0,2,1> | <1,-1,2> |< 2,-2,4> | <1,1,0> >:
> b := < 1,-1,5 >:
> m1 := < A | b >;

m1 :=

0 1 2 1 1
2 −1 −2 1 −1
1 2 4 0 5


> m2 := RowOperation( m1,[1,2] );

m2 :=

2 −1 −2 1 −1
0 1 2 1 1
1 2 4 0 5


> m3 := RowOperation( m2,[3,1],-1/2 );

m3 :=

2 −1 −2 1 −1
0 1 2 1 1
0 5/2 5 −1/2 11/2


> m4 := RowOperation( m3,[3,2],-5/2 );

m4 :=

2 −1 −2 1 −1
0 1 2 1 1
0 0 0 −3 3


This matrix is now in echelon form. We could use the procedure BackwardSubstitute
at this point but instead we will carry out the backsubstitution on the matrix itself.

> m5 := RowOperation( m4,3,-1/3 );

m5 :=

2 −1 −2 1 −1
0 1 2 1 1
0 0 0 1 −1


> m6 := RowOperation( m5,[2,3],-1 ):
> m7 := RowOperation( m6,[1,3],-1 );

m7 :=

2 −1 −2 0 0
0 1 2 0 2
0 0 0 1 −1


> m8 := RowOperation( m7,[1,2],1 );

m8 :=

2 0 0 0 2
0 1 2 0 2
0 0 0 1 −1


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> reduced := RowOperation( m8,1,1/2 );

reduced :=

1 0 0 0 1
0 1 2 0 2
0 0 0 1 −1


We now have the fully reduced form and we can read off the general solution as

[1, 2− 2λ, λ,−1]

where λ is an arbitrary parameter representing an arbitrary choice of the third variable.
When Maple is solving systems of linear equations, it uses names like t1 , t2 for

arbitrary parameters which may occur in the general solution. So the solution of the
above set of equations would be displayed as

[1, 2− 2 t1, t1,−1]

if you were using Maple, or as [1, 2-2*_t[1], _t[1], -1] in text files or when
you are using plain Maple without a Maple window.

In the above example, intermediate matrices were assigned to named variables so that
we could go back to an earlier stage if we found that we had made a mistake. Alternatively
you could simply use % to apply each command to the previous result. The above example
would then start with something like

<A | b>;
RowOperation( %,1,2 );
RowOperation( %,[3,1],-1/2 );
RowOperation( %,[3,2],-5/2 );

The LinearAlgebra package also provides procedures which do all or parts of the Gaus-
sian elimination process in one step. In particular, you can use:

GaussianElimination(A) gives the row-echelon form of A
ReducedRowEchelonForm(A) gives the fully-reduced form of A
BackwardSubstitute(W) does backsubstitution on a matrix W in echelon

form, assuming that W has been been derived
from an augmented matrix of the form (A|b)

LinearSolve(A,b) solves A.x=b
Basis( {v1,v2,...,vn} ) finds a basis for the vector space spanned by

the set {v1, v2, . . . , vn} of Vectors.

NOTES:

1. Maple does all its reductions using rational numbers, unless the original matrix
had some floating point numbers in it. If you want to see the results in floating
point, apply evalf in the way which was described in section 2.5.7. If the matrix
involved is large and has floating point entries, the procedures GaussianElimina-
tion, ReducedRowEchelonForm and LinearSolve will not always give exactly
correct answers because of problems with rounding errors when doing floating point
arithmetic.
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2. Maple can solve linear sytems with unknown parameters in them. In particular, it
can solve systems in which each of the entries in the righthand side is an unassigned
variable, for example

b := < b1 , b2 , b3 >;

3. If you are doing MATH1231 or MATH1241, you should look up the Maple help files
for the procedures Rank, RowSpace, ColumnSpace, Transpose, Determinant,
Eigenvalues, Eigenvectors, CharacteristicPolynomial. To anyone who
has studied the linear algebra section of MATH1231/1241, the effects of these
procedures should be obvious from their names.

2.12 Vector and Matrix Arithmetic
The last section shows how to create and display Vectors and Matrices. However, we

cannot do any useful linear algebra without first loading the LinearAlgebra package,
which provides many procedures for dealing with Vectors, Matrices and linear equations.
(Technically, LinearAlgebra is called a module, but you can ignore this distinction.)
In these Notes we will only give an outline of some of the basic procedures. To find out
more about these and other procedures available in LinearAlgebra, use Maple’s Help.

To use the procedures in this package, it is easiest to first load it with the command

with(LinearAlgebra):
Note the use of the colon here, which supresses the (very long) list of new funcitons in
LinearAlgebra.

However, you can use a command directly by giving its full name: you do this by
adding LinearAlgebra:- to the start of the command. This is what Maple will do if
you operate with the context sensitive menus (see section 1.3.4).

Vectors and Matrices can be added, subtracted and multipled by scalars using the
usual operators +, - and *. Two Matrices can be multipled using the . operator. The
. operator is also used to give the dot product of two Vectors. A square Matrix can be
raised to an integer power using ^.

For example, to find the linear combination 2v− 3w of the vectors v and w we use

2*v - 3*w;
and we can enter the formula for a general point on the line through the points with
position vectors v and w (i.e. the formula x = (1 − λ)v + λw , where λ is an arbitrary
parameter). We do this by

x := (1-lambda)*v + lambda*w;
Note that A^(-1) gives the inverse matrix.

When using these operations, you must of course ensure that the Matrices and Vectors
are of the appropriate dimensions and, in the case of the negative power of a matrix, that
the matrix is invertible.

If you enter an expression involving these operations, Maple will automatically carry
out the operations. For example, to enter the mathematical expression Ax + b , we use

A.x + b ;
If values have already been assigned to A, x and b then A.x+b will be evaluated, but if
some of these variables are unassigned then you will get an answer involving the unassigned
variables.
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A useful convention in Maple is that, in expressions involving matrices, a scalar con-
stant can be treated as that scalar multiple of an appropriate identity matrix I . For
example, if A is a square matrix then the command

1 + A + 2*A^2 ;
evaluates the polynomial expression I + A + 2A2 , where I is the appropriate identity
matrix. This convention enables you to substitute matrices into polynomials. For exam-
ple,

subs( x=A, 1+x+2*x^2 );
gives the expression I + A+ 2A2 (because the 1 is interpreted as an identity matrix).

If you use the dot with two Vectors of the same size, Maple will calculate their dot
(inner) product. So

v := <2,1,2> : w := <-4,2,1>:
v.w;

will return −4 , the dot product of the two vectors.
The transpose of a Matrix or Vector is given by the Transpose function from the

LinearAlgebra package. For example, if A is a 2 by 3 Matrix, then Transpose(A) is
the 3 by 2 Matrix which is the transpose of A. If v is a Column vector, then Transpose(v)
is the corresponding row Vector.

2.13 Vector Geometry
Maple provides facilities for doing geometry in Rn and, in particular, in R3 .

2.13.1 Dot and Cross Products, Length
The LinearAlgebra package provides the procedures

DotProduct(v,w) (or v.w) dot product of v and w
CrossProduct(v,w) cross product of v and w

To calculate the length of a vector, you need to use the procedure Norm, in the
LinearAlgebra package, but it must be used with care. If v is a Vector, then the
command Norm(v,2) will give the length of the Vector. (The reason for the 2 is that
Norm can be used for rather more general purposes which you will not need to know about
in first year mathematics.)

There is also a distance procedure in the student package, which gives the dis-
tance between two points (represented by lists or Vectors). Use Maple’s Help for more
information.

2.13.2 Three-dimensional Geometry.
The package geom3d contains many useful procedures for solving problems in R3 .

In fact, many of the geometric problems involving planes from the MATH1131 Algebra
Notes can by solved with procedures in geom3d. The following is an outline of some of
the things which you can do with geom3d.

The method of assigning a name to a point, line or plane is not quite what you might
expect. To say that A is the point (1, 2, 3) , you do NOT enter A := [1,2,3]; — this
is assigning a point to a name. You enter point(A,[1,2,3]); — you are assigning
a name to a point. The command line is used to assign a name to a line. The line
may be specified by giving two points on it or a point on it and a direction parallel to it.
The command plane is used to assign a name to a plane. The plane may be specified
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by giving a cartesian equation for it or three (non-collinear) points on it or a point on
it and a normal direction or a point on it and two lines parallel to it. The command
sphere is used to assign a name to a sphere. A sphere may be specified by giving its
cartesian equation or four points on it or the end-points of a diameter or its center and its
radius. To display the specifications of one of these things you need to use detail (see
the example below). For a plane, the detail includes a cartesian equation for the plane.
If you want to find a normal to a plane p use

NormalVector(p);
Be warned that if you specify a plane or sphere by means of an equation then Maple

will want you to specify the names of the variables which are associated with the three
axes. You can do this by listing them as a third argument to the plane or sphere
command, as in

plane(P,x+y+z=1,[x,y,z]);
If you leave out the [x,y,z] then Maple will, rather strangely, prompt you with the

request enter the name of the x-axis, to which you reply x;, and similarly for
the other two axes. The semi-colons are compulsory here. Depending on the way Maple
is set up, this might be done using a pop-up dialogue box.

When you have set up objects of these types you can, for example, use the command
distance to find the distance between two of them or the command intersection
to find the intersection of two of them or the command FindAngle to find the angle
between two of them (where appropriate).

You can also use Equation to find a cartesian equation for a line, plane or sphere
and center for the center of a sphere and coordinates to find the coordinates of a
point.

Use the Maple Help to find out more about any of these commands and to find out
about the many other commands available in geom3d.

In the following example, we first label the points A(0, 1, 2) and B(2, 3, 1) and the
line AB through A and B . Applying detail to AB shows that the direction of the
line is (2, 2,−1) and the line can be expressed in parametric vector form as

x =

0
1
2

+ t

 2
2
−1

 , t ∈ R.

Then we assign the label P to the plane through C(4, 5, 6) with normal (1, 1, 1) and
use detail to find that P can be described by the cartesian equation

x+ y + z = 15.

Then we assign the label X to the point of intersection of the line AB and the plane
P and find that the coordinates of X are (8, 9,−2) . Next we find that the plane ABC
through the three points A,B,C can be described by the cartesian equation

12x− 12y + 12 = 0.

Finally, we find the sphere S passing through A , C , X and Y (0, 7, 4) this time giving
the coordinates axes as x , y and z and calling its centre Q , and see that it has volume
288π , its equation is

5 + x2 + y2 + z2 − 8x− 10y = 0,
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and so on.

Notice that we use a colon : to suppress the output of most of the commands because
the output would just be an echo of assigned names.

with(geom3d):

Warning, the name polar has been redefined

point(A,[0,1,2]),point(B,[2,3,1]):

line(AB,[A,B]):

detail(AB);
Warning, assume that the parameter in the parametric equations is t

Warning, assuming that the names of the axes are x, y, and z

name of the object: AB

form of the object: line3d

equation of the line: [ x = 2* t, y = 1+2* t, z = 2- t]

point(C,[4,5,6]):

plane(P,[C,[1,1,1]]):

detail(P);

Warning, assuming that the names of the axes are x, y, and z

name of the object: P

form of the object: plane3d

equation of the plane: -15+ x+ y+ z = 0

intersection(X,AB,P):

detail(X);

name of the object: X

form of the object: point3d

coordinates of the point: [8, 9, -2]

plane(ABC,[A,B,C]):

detail(ABC);

Warning, assuming that the names of the axes are x, y, and z

name of the object: ABC

form of the object: plane3d

equation of the plane: 12+12* x-12* y = 0

point(Y,[0,7,4]):

sphere(S,[A,C,X,Y],[x,y,z],centername=Q):

detail(S);

name of the object: S

form of the object: sphere3d

name of center: Q

coordinates of center: [4,5,0]

radius of sphere: 6

surface area of sphere: 144*Pi

volume of sphere: 288*Pi

equation of the sphere: 5+x^2+y^2+z^2-8*x-10*y = 0
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2.14 Partial Derivatives
If f is an expression which contains several unknowns (one of which is x) then the

result of the command

diff(f,x);
is the partial derivative ∂f/∂x . Similarly, the command

diff(f,x,x);
gives you the second order partial derivative with respect to x. If f is an expression in
unknowns x and y (and maybe other unknowns as well), the mixed second order partial
derivative ∂2f/∂y∂x is given by

diff(f,x,y);

If f is a function, then you need to use either of the two methods in section 2.4.2. For
example, if f is a function of two variables, then the first method becomes

diff(f(x,y),y);
In the second method, use the D operator followed by numbers in square brackets to
indicate the variable with respect to which you are differentiating. For example, if f has
been defined as a function of two variabels then

D[2](f);
gives you the partial derivative with respect to the second variable and

D[1,2](f);
gives you function of two variables given by the mixed second order partial derivative
∂2f(x, y)/∂y∂x and

D[1,2](f)(3,-2);
gives the value of that mixed derivative evaluated at the point (3,−2) .

Note: All derivatives in Maple are partial derivatives and this is the reason why Maple
insists on a second argument for the diff command.

2.15 Ordinary Differential Equations.
The procedure dsolve is used to solve ordinary differential equations (ODEs). You

enter the ODE as an equation involving the function, say y(x), differentiated appro-
priately with respect to x. For example to solve (i.e. find the general solution of)
y′ + y = sinx+ x you would use

dsolve( diff(y(x),x)+y(x)=sin(x)+x, y(x) );
and for the more complicated equation

xy′ + y(x2 + ln y) = 0

you would use

dsolve( x*diff(y(x),x)+y(x)*(x^2+ln(y(x)))=0, y(x) );

and to solve

y′′ − 2y′ − 3y = 2x

you would use

dsolve( diff(y(x),x,x)-2*diff(y(x),x)-3*y(x)=2*x, y(x) );
In the resulting general solutions, arbitrary constants are shown as _C1, _C2 etc.
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NOTES:

1. The dependent variable y(x) must always be written completely as y(x) and never
just as y — Maple will give you a warning message if you mix the two. The
derivatives must be written out explicitly and you must say what variable you are
solving for. In some cases Maple will not solve for this variable explicitly — it will
only give you the implicit definition of the solution (just as you would if you were
doing it yourself). Also, you may of course use variables other than x and y.

2. It is important to be aware that the output of dsolve is an equation. It does not
define y(x) as a function of x . If you want to use the expression on the right hand
side of the output equation, you must extract it using the command rhs(%).

Often it is useful to have the differential equation in pieces so that you can manipulate
it outside the dsolve or use it more than once. For example, the second order ODE
given above could have been solved via the following:

leftside := diff(y(x),x,x) - 2*diff(y(x),x) - 3*y(x);
ODE := leftside = 2*x;
dsolve( ODE,y(x) );

which is perhaps more readable and more useful if you want to go on to find a particular
solution subject to some initial conditions. Resist the temptation to use the names left
and lhs in this context: they are Maple reserved words.

Solving ODEs subject to initial conditions is treated as solving a set of equations, some
of which are simply the initial conditions. For example, the condition y(0) = 3 is simply
written as y(0)=3. When there are derivatives in the initial conditions, you must use
the D operator to differentiate so that you can evaluate at the same time. For example,
the condition y′(0) = 1 is entered as D(y)(0)=1. Notice that this is the derivative of y
evaluated at 0. (It is not D(y(0)), which is just 0 because y(0) is a constant.)

To solve the equation ODE subject to the initial conditions y(0) = a , y′(0) = b , use
the command

dsolve( {ODE,y(0)=a,D(y)(0)=b}, y(x) );

Note the curly brackets { } which indicate that we are giving Maple a set of equations.

There are options to solve ODEs using series and other methods. Use Maple’s Help
to get more details.

2.16 Taylor Series.
Taylor series can be found using Maple via the taylor procedure. For example,

taylor( exp(x), x=0, 5 );
will give you first five terms (i.e. the constant through to the term of degree 4) in the
well known Taylor series for ex . The display will end with O(x^5) to show you that the
remainder is of order x5 .

For series about other points, simply put a different value after the x=. For example,
the command

s := taylor( exp(-x)*sin(x), x=Pi/2, 8 );
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will find the first eight terms (i.e. up to and including the term of degree 7) in the Taylor
series about the point x = π

2
(i.e. in powers of (x − π

2
) ) for the the function e−x sinx

and it will assign the result to the variable s.
Note that Taylor series are not polynomials and cannot be treated as such, hence

there is a procedure to convert a Taylor series into the corresponding Taylor polynomial.
For example, to convert the Taylor series that is in the variable s above into a degree 7
polynomial in powers of (x− π

2
) use

convert(s,polynom);

2.17 Discrete Mathematics.
Maple provides a number of procedures which will be useful to students in the first year

Discrete Mathematics courses. In this section we only give hints as to what is available.
See also an example of a recursively defined function in section 2.21.1.

2.17.1 Greatest Common Divisors
The procedures igcd and ilcm are used for finding the greatest common divisors and

least common multiples of integers (the i in these words stands for integer). For example

igcd(234,57);
gives an answer of 3 .

You can also find numbers x and y satsifying ax+ by = gcd(a, b) . Use the command

igcdex(a,b,x,y);
where x and y must be unassigned variables. This procedure will calculate the gcd and
assign the appropriate values of x and y to the variables x and y. You can then see
these values by entering x; and y;. The ex at the end of the igcdex command name is
there since Maple is using the extended Euclidean algorithm.

The variables x and y used in this command must be unassigned . If necessary, put
them in forward-quotes to remove any previous assignment, as in

igcdex(a,b,’x’,’y’);

2.17.2 Modular Arithmetic
There are a number of procedures for working with modular arithmetic.

a mod m positive remainder when a is divided by m
Power(a,b) mod m ab with all arithmetic done mod m
a^(-1) mod m inverse of a mod m
etc

Note the use of the inert procedure Power rather than the usual a^b. The Power form
does not evaluate until the mod part is reached. If you used a^b mod m then Maple
would first compute ab and afterwards reduce the answer mod m , whereas Power(a,b)
mod m will do all the calculations mod m and this makes the calculation much faster.

2.17.3 Set Algebra
There are procedures union, intersection and minus for doing set algebra.

Use Maple’s Help to check the details. Note that there are also functions member and
subset, which return true or false as appropriate.
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2.17.4 Solving Recurrence Relations
Recurrence relations (or difference equations) can be solved by using the command

rsolve.
When solving for a sequence {an} , write a(n) for an , a(n-1) for an−1 , etc. For

example, to find the general solution of the Fibonacci recurrence an = an−1 + an−2 , use

rsolve( a(n)=a(n-1)+a(n-2), a(n) );
The a(n) after the comma tells Maple which variable to solve for. Note that a(n) must
be written out in full, do not just put a.

Solving a recurrence relation subject to initial conditions is treated as solving a set of
equations, some of which are the initial conditions. For example, to solve the Fibonacci
recurrence with the initial conditions a0 = 0 and a1 = 1 (hence giving the Fibonacci
numbers) you can use

reln := a(n) = a(n-1) + a(n-2);
fibn := rsolve( {reln,a(0)=0,a(1)=1}, a(n) );

Note the use of curly brackets here to denote a set.
The solution to a recurrence will often often involve messy expressions (as in the

Fibonacci example). You may need to use the simplification commands described in
section 2.3.3. For example, after carrying out the above Fibonacci example try

subs( n=7, fibn );
radsimp( %, ’ratdenom’ );

You will get a complicated expression after the first command which simplifies to give 13
as the value of the seventh Fibonacci number. In other cases you may need to use evalf
to get an approximate floating point answer.

You can also use loops to calculate the values of a recurrance relation: see section 2.20.1
for an example.

2.18 Assuming properties.
The current version of Maple has a feature that enables you to assume that vari-

ables have certain properties. (Early versions did not have this feature and consequently
sometimes made mistakes.)

For example, Maple cannot give you a value for lim
x→∞

e−ax unless it knows whether a

is positive, negative or zero. You can tell Maple that a is positive by giving the command

assume(a,positive);
before giving the command to evaluate the limit.

Maple sometimes needs an assumption to be made when you might not think it is
necessary. This is because Maple usually assumes that variables take complex number
values and this may cause problems. If Maple does not evaluate something when you think
it should, it might be useful for you to assume that the variables are real, integer or
positive.

The syntax for assuming properties for variables is

assume(variable,property);
where property can be one of many things including complex, real, positive and
integer. To see a full list of the possible properties, look at the help entry for assume.

If a range of values is being assumed, you can use a single inequality of the type

assume(variable>value);
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Only one assumption at a time can be made using assume. If you use assume twice
on the same variable then the first assumption is lost. However, you can make additional
assumptions with the command additionally. It is used in the same way as assume.

To find out what assumptions have been made about a variable, use

about(variable);
and Maple will display all assumptions about that variable.

For example, to assume that the variable a is a positive integer and check the assump-
tions on a and then evaluate the limit of e−ax as x→∞ you could say

assume(a,integer);
additionally(a>0);
about(a);
limit( exp(-a*x), x=infinity );

To show that a variable has had an assumption made about it, Maple puts a ~ after the
variable name. For example, the variable a with an assumption having been made about
it will always be displayed and printed as a~. This sometimes looks like a -, so take care
when reading the Maple output. There is no need for you to type the ~ when using the
variable.

An assumption about a variable can be removed by unassigning the variable in any of
the ways described in section 2.2.3.

There are other details about making assumptions, such as the assuming command,
and you can check the relevant help entries if you want to know more.

Exercise What happens when you enter
sqrt(x^2) assuming( x,negative );
about(x);

2.19 Conditions and the if – then construction.
Suppose that you want a sequence of commands to be carried out if and only if a

certain condition is satisfied. This often happens when you are writing the definition of a
procedure. You can achieve the desired effect with an if . . .then construction, but first
you need to know how you can express conditions in Maple.

2.19.1 Conditions
Conditions are equations or inequalitities or other expressions that are either true

or false. In stating conditions, you can use =, >, >=, <, <= and the symbol <> which

means ‘not equal’. Conditions can be combined by using the logical or, and and not.

For example

if x>3 or y<=2 then ...

if a>b and not (c>d) then ...

if not isprime(x) then ...

In the last example, isprime is a Maple procedure which gives the value true if x
is a prime number and false otherwise. There are other procedures of this sort — use
Maple’s Help Browser to find them.

Conditions are also called Boolean expressions, and if you use them in an if
statement, for example, and an error occurs in the condition, Maple will refer to the
condition as a boolean, which should give you a clue as to where the error is.



52 CHAPTER 2. MAPLE COMMANDS AND LANGUAGE.

2.19.2 The if – then construction

As an example, the following commands are a procedure to find the absolute value of

a real number.

absval := proc(x)

if evalf(x)>=0 then

x;

else

-x;

end if;

end proc;

The general shape of the if command is something like

if condition1 then
commseq1

elif condition2 then
commseq2

elif condition3 then
commseq3

else commseq4
end if:

where commseq1 etc are sequences of commands (each finishing as usual with : or ;)
and condition1 etc are conditions that are tested for their truth. The action of such an
if command is to test if condition1 is true and if it is true then execute (carry out) the
commands in commseq1, while if it is not true then Maple tests condition2. If this is true
then Maple executes commseq2, and if it is not true then Maple tests condition3. If this is
true then Maple executes commseq3, and if it is not true then Maple executes commseq4.

An if command needs the first if and then and the final end if, but the other
parts are optional, depending on what is required. We have seen this above and there are
further examples in section 2.21.1.

You do not have to put : or ; after the then (though it will not matter if you do),
but you MUST put one after the end if.

2.20 Looping with for and while.
Suppose that you want to execute a set of Maple commands several times, changing

the value of one variable n at each repetition. This is called creating a loop, and is very
common in scientific programming.

The way you create the loop depends on whether you know in advance exactly how
may times you want to repeat the commands or not. If you know that you want to repeat
the commands 100 times then you can use a construction of the type ‘for n from 1
to 100 do . . .’. If you do not know how many repetitions you want to make then you
will have to tell Maple to keep repeating until some condition is no longer satisfied, using
a construction of the type ‘while . . . do . . .’.

As an example of the first type of situation, consider the following piece of Maple.
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for n from 0 by 2 to 4 do

print(‘(a+b) to the power‘,n,‘equals‘,expand((a+b)^n));

end do:

The resulting display will be

(a+ b) to the power, 0, equals, 1
(a+ b) to the power, 2, equals, a2 + 2ab+ b2

(a+ b) to the power, 4, equals, a4 + 4a3b+ 6a2b2 + 4ab3 + b4

This display shows the expansion of (a + b)n for each of the values n = 0, 2 and
4. We terminate this ‘for–loop’ with end do:, using a : rather than a ;, so that any
intermediate results will not be printed on the screen. We use the print procedure to
force display of the things that we want to see. In the argument to the print procedure,
text contained between back-quotes will be echoed in the printout and variables which
occur outside back-quotes will have their values printed.

It is possible to print things nicely using a specified format. This is done using the
printf procedure which works the same as it does in the C programming language. We
will not go into any details here — use Maple’s Help if you want more details.

As an example of a situation where you need to use while, here is a loop that finds
the first value of n for which the sum

n∑
k=1

1

k

is greater than 5.

total := 0; # Note that sum is a reserved word
for n while total<5 do

total := total+1/n;
end do:
n;

The for n part tells Maple that n is the variable which should be increased at each
repetition. Since no starting value or increment are specified, Maple assumes that you
want to start at n = 1 and increase n by 1 at each repetition. Again note the full colon
: at the end of the loop rather than a semicolon ; — this is to stop the display which
would otherwise be produced at the end of each loop.

The most general possible form of Maple’s looping construction is quite complicated,
but you can leave out the parts you do not need. The general form is

for variable from start by step to finish while condition do
command sequence
end do:

The command sequence is called the body of the loop.
You do NOT need a ; or : after the do (though it does not matter if you put one

there), but you MUST have a : or ; after the end do.
The body of the loop is repeated once for each value of the ‘index’ variable, say n .

Initially n is given the value of start . If this value is less than or equal to that of finish and
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the condition is satisfied then the body of the loop is carried out. Note that this means
that in Maple it is possible for the body of the loop not to be run, unlike some other
computer languages in which a loop is always run at least once. Then n is increased by
the value of step. If its new value is less than or equal to that of finish and the condition
is still satisfied then the body is carried out again. This process continues until the value
of n is greater than that of finish OR the condition becomes false (whichever is first). At
this point the loop ends. The final value of n is the first of the values start , start+step,
start+2*step, ... that exceeds finish OR the first of these values at which the condition
is false (whichever is the lesser).

The start , step and finish must have values that are numbers. If the value of step is
negative then the obvious changes to the above description must be made.

If the from start or the by step is omitted then a value of 1 is assumed. If the
while condition is omitted, then it is assumed to always be true. If the for variable
is omitted, then the loop is carried out for the specified number of times and exactly
the same unchanged sequence of commands is performed at each repetition. You can
leave out everything except the while . . . do . . . end do:, provided that you have
assigned an initial value to the variable occurring in the condition and that the value of
this variable is changed by commands in the body of the loop. For example, the following
commands apply the Euclidean algorithm to find the greatest common divisor of 3960
and 3780.

a := 3960; b := 3780;

while b<>0 do

r := a mod b;

a := b;

b := r;

end do:

print(‘gcd is‘,a)

Take extreme care with looping because you can very easily set Maple off on an infinite
loop, or at least a very long loop that will take you past your time limit and completely
ruin your Maple session. The STOP button does not always stop a loop.

The commands break and next can be used in for loops to change the normal
procedure. If a break is encountered, then that loop is immediately finished, and the
command after the end do is carried out. If a next is encountered then the remaining
part of the body of the loop is skipped, down to the end do, and the loop continues with
the next value of the index variable.

Loops can be contained one completely inside another when you wish to do more
complicated things.

2.20.1 Two further examples
Some of you will learn, or have learnt, to program in other languages and may have

come across a type of loop called a repeat . . . until loop, where a condition is tested
at the end of the loop and not (as in Maple) at the beginning. Since it is not logically
necessary to have both types of loop, Maple only has while loops. Some problems are
more natural with a test at the end — the summation example above for instance. To
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rewrite these as while loops requires a bit of thought. The following two examples show
how to get around this.

Suppose you wish to find the first Fibonacci number that is larger than 1000 . The
natural way to do this is to calculate each number, check to see that it is smaller than
1000, if not, then calculate the next one and repeat. But we cannot check the size of the
number at the end of a loop in Maple, only at the start. To get around this, we do the
following:

a[0] := 0: a[1] := 1:

for n from 1 while a[n] <= 1000 do

a[n+1] := a[n]+a[n-1]

end do:

At the end of this loop a[n] will contain the first Fibonacci number greater than
1000, which is 1597 . Note that the colon after the end do supresses the printing of
the intermediate values. If you enter op(a) you will see a table with all the Fibonacci
numbers that were calculated.

As a second example, suppose you are trying to use Newton’s method to find the
square root of 5 , starting from a guess of 2 . The you would be calculating successive

iterates xn using the formula xn+1 =
1

2

(
xn +

5

xn

)
. Suppose we decide to find the first

xn with |xn − xn−1| < 10−6 . This can be done as follows:

x[0] := 2: x[1] := evalf((x[0]+5/x[0])/2):

for n from 1 while abs(x[n]-x[n-1]) >= 10^(-6) do

x[n+1] := evalf((x[n]+5/x[n])/2);

end do:

What this loop does is succesively calculate xn as long as the difference |xn − xn−1|
is greater than or equal to 10−6 . Once it is is not, the loop finishes. So at the end of this
loop x[n] has the desired value.

2.21 Functions and Procedures.
2.21.1 Procedures.

The functions defined by the arrow operator are a special case of a procedure. The
general form of a procedure is as follows.

procedurename := proc (variables)
command sequence
end proc:

where each command line in the command sequence ends with a ; (or :) and variables
is a sequence of none, one or more variables.

There is no need for a : or ; on the first line, but you MUST put one after end proc.
A semi-colon ; after end proc will result in a display of the definition of the procedure
and a colon : will suppress this display.
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The procedure is used in the form procedurename(variables) and the value produced
as the result of the procedure is the last value calculated within the procedure. Rather
than relying on this fact, it is better practice to use return value to force the proce-
dure to end at a particular point and produce value as the result of the procedure. For
example, to define the (piecewise) function in section 2.8 given by

f(x) =


0 if x < 0;
x2 if 0 ≤ x < 1;
2x− 1 if 1 ≤ x,

we could use the Maple procedure

f := proc(x)
if x<0 then return 0
elif x<1 then return x^2
else return 2*x-1
end if;

end proc:

This definition will give 0 for f(-1),
1

4
for f(1/2) and 5 for f(3).

If you wish to use one or more variables only inside the procedure, it is good practice
to declare them to be local variables. For example, you may wish to use the variable i
with a for loop. To do this, place the Maple command local i; at the top of your
procedure definition. For example, a simple function or procedure to sum the first n
integers could be defined in the following way (note that there are better ways to do this!)

f := proc(n)
local i, s;
s := 0;
for i from 1 to n do

s := s + i;
end do;
s;

end proc;

If you want to see the description of a procedure after it has been defined, use

eval(procedurename);
or

print(procedurename);

For further details on procedures, see the material in the Discrete Mathematics courses
MATH1081 and MATH1090 course packs.

Procedures in Maple can be recursive, in other words they can use themselves as
part of the definition of themselves. Great care must be exercised when using recursive
procedures because they can easily become circular and run you over your memory and
time limits, and frequently they are hard to understand and may be more time consuming
to run than other ways of writing code to do the same task. Recursion is studied in the
Discrete Mathematics courses MATH1081 and MATH1090.

Here is a simple example of a recursive procedure which can be used to find the n th
Fibonacci number (though there are better ways to find the Fibonacci numbers.)
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f := proc(n)
option remember:
if n=0 then return 0
elif n=1 then return 1
else return f(n-1)+f(n-2)
end if:

end proc:

Check that this gives the same value for f(7) as we earlier got by explicitly solving the
Fibonacci recurrence. Also try f(100) — but be careful because the Fibonacci numbers
grow very quickly.

Note the use of the command option remember. This tells Maple to remember any
values it finds as it does the calculations. Then it can look them up when it needs them
again, rather than recalculating them. With the option remember present, f(100)
evaluates the procedure 100 times. Without this option the number of evaluations to get
f(100) would be more than 1020 .

Other options are possible. For example, using the arrow operator is equivalent to
including the options operator and arrow, that is, x -> 2*x-1 is equivalent to

proc(x) options operator, arrow; 2*x-1 end proc

2.22 Common Mistakes
When doing tests or assignments or just using Maple, there are several common errors

that are made. Many of these have already been mentioned in these notes, but we collect
them together here. Do not forget that you have on-line help at all times when using
Maple, and there are Consultants available at the appropriate times (see your course
information booklet for details).

1. Incorrect punctuation. For example, forgetting a colon, semi-colon at the end of a
line; forgetting commas; using the wrong shape of brackets e.g. [. . . ] instead of (..)
and conversely.

2. Confusing functions with expressions and misuse of subs: see 2.3.2.

3. Assigning values to one letter variables (e.g. t, x etc.) and then trying to use them
as variables (see page 16).

4. Forgetting to load a package. If Maple just repeats a command you’ve given it then
it doesn’t know what the command means, so you have either misspelt it or not
loaded the package.

5. Forgetting brackets in functions. For example, for tan x you need to use tan(x)

and not tan x.

6. Misuse of the exponential. For ex you need to use exp(x), and not e^x nor exp^x

— the latter can cause Maple to freeze up, or even to crash.

7. Not translating common notational abuses correctly. For example, when we write
sin2 x we mean (sinx)2 , and you have to write the correct form in Maple, that is
(sin(x))^2 or nothing will work.

For other possible problems, look up the various warnings using the index.
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2.23 Reading Files into Maple.
Suppose that you are running a Maple session and you wish to use a sequence of

commands in a file. There are two essentially different ways of doing this, each with a
different effect.

1. If the commands in a Maple worksheet (.mw) or Maple Input file (.mpl) file then
you can open a new worksheet containing the text of the commands by a method
similar to that for saving a Maple session given in section 1.4.

(a) Click on the second button from the left in the tool bar (it looks like a half-open
folder): a dialogue box called Open will appear.

(b) At the bottom of this dialogue box, you will see a box labelled Filetype which
looks something similar to:

All Worksheets (mw, mws) ∇

(c) If you want to open a Maple Input file, click on the symbol ∇ and a menu
will appear. Clicking on the Maple Input line. If you want to open a .mw

file, ignore this step.

(d) The main part of the dialogue box will be a list of all the .mw (or .mpl) files
in your home directory. If the file is there then click on it and the name will
be transferred to the box beside the word File Name.

(e) Otherwise, move the mouse pointer into that box and enter the name of the
file you want to read including the file extension.

(f) Click on the word OK.

(g) If you are opening a Maple Input file then all the commands are placed in one
execution group, which is generally unhelpful.

The commands in this new worksheet will not be executed unless you go through
them pressing <Enter> in each execution group. This method is good if you want
to modify the commands before executing them. Alternatively, select Execute
from the Edit menu (see 3.7) or click on the Execute Icon (three exclamation
marks).

2. If the file is a Maple Input file then the command

read( filename );

will execute the commands in your file and display the results in your Maple work-
sheet, but it will not display the text of the commands. If filename contains any
special characters it must be surrounded with back-quotes ‘ as in

read( ‘proc.mpl‘ );

The read command is usually used when you have defined a procedure (or some-
thing that takes a lot of typing, like a matrix) which you want to use in more than
one Maple session (or more than once in a session) since the commands are executed
immediately each time the read command is used.

Warning: If you use a read command in a Maple command file that you
are submitting as an assignment, remember that you must submit the file that is
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read as well as the command file, otherwise we cannot process the submission for
marking. Remember that read does not give you a copy of the commands it carries
out, only their results.

3. It may happen that there are commands that you want to read in every time you
start a Maple session. You can do this automatically by putting the commands
in a file called .mapleinit in your home directory. This file will automatically
be read in at the start of each and every Maple session (including when you use
restart).

Note: Every time you login to a Linux PC in the Red Centre lab a new .mapleinit
file may be placed in your home directory by the system administrator. This over-
writes what was there before and so you should be careful to keep a backup of your
own version.

Also DO NOT put any commands which you use in an assignment into your
.mapleinit file unless you also include them in the submitted file itself.

2.24 More Maple.
There are literally thousands of other commands and procedures that Maple under-

stands and some of them may be of interest to you. You can explore these for yourself by
using Maple’s Help.

There are many books on Maple (all using Release V, although some updated editions
were in press at the same time as these Notes) including

“Maple V Flight Manual” by W. Ellis, E. Johnson et al (Brooks/Cole 1992).
“First Steps in Maple” by W. Burkhardt (Springer 1994).
“Linear Algebra with Maple V” by E. Johnson (Brooks/Cole 1993),
“Calculus the Maple Way” by R.B. Israel (Addison-Wesley 1996),
“Introduction to Maple” by A. Heck (Springer 1993, 1995).

You do NOT need to purchase any of these books to do the Maple computing in First
Year because what you need to know is contained in these Notes. Nevertheless, you may
find them useful.





Chapter 3

MORE ON THE MAPLE GUI.

The Maple GUI (Graphical User Interface) was introduced in chapter 2, where some of
its features were described. In this appendix, we build on what was said there and give a
more complete treatment of Maple’s features.

3.1 Maple’s Default Settings
Maple is installed on all PCs (both Windows and Linux) in the School of Mathemat-

ics and Statistics labs. However, the default settings have been modified to simplify the
interface. If you buy your own copy of Maple for use at home, you are strongly encour-
aged to modify the settings of your copy to match those in the lab. This is because all
documentation provided in your course assumes you are using a Maple in the School’s
labs and any Maple tests in our lab will use those settings.

The first time you start Maple after installing it with the default settings you should
see a window like the one in Figure 3.1.

Figure 3.1: Maple with default settings

61



62 CHAPTER 3. MORE ON THE MAPLE GUI.

3.2 Maple Settings in the Labs
To modify the default Maple settings to match the lab settings, do the following:

• Close the palette (the region of the left of the Maple window containing lots of wide
buttons). To close the palette, click on the triangle pointing left at the top of the
bar between the palette and the main document area of the Maple window.

• From the Tools menu select Options . . . .

– Click on the Display tab and for the first item called Input display select
Maple notation.

– Click on the Interface tab and for the fourth item called Default format

for new worksheets select Worksheet.

– Click on the Apply Gobally button to save the new settings and close the
options window.

• Select Maple Help from the Help menu. Then click on the Help window’s View

menu and select Display examples with 2D math (this needs to be turned off).

• Close all Maple windows to save the changes you’ve made to the settings.

Next time you open Maple and start a new worksheet, it should open with 1-D maple
input, the palette closed, large toolbar icons and help pages should use 1-D Maple input
notation. Figure 3.2 is Maple with all of these settings with a Maple worksheet open.

For information of other settings that you may find useful, see section 3.11.1.

3.3 A Maple Window
We see that, apart from the usual window bar at the top and the scroll bar on the

right, the Maple window is split into five parts. At the top is the menu bar (some of
which are “greyed out” in figure 3.2). Then comes the tool bar with several ‘buttons’
providing shortcuts to common operations. Below this is the context bar which changes
depending on what you are doing. For all of the options in the tool bar and context bar
some help text will pop up if you leave your mouse over the icon.

Below these bars is the main area of the window which contains the worksheet, and
at the bottom is the status bar.

3.4 Worksheets and Documents
Maple 10 introduced two different ways of using Maple, which they call worksheets

(which we have set to be the default) and documents (which is the Maplesoft default).
We mention documents because it is the original default, and some of Maplesoft’s tutorials
are written with them. Documents are more suited to the preparation of book quality
notes, which you will not need to do, and require more effort to use. If you wish to
explore their use, then you can open a document-mode Maple window from New on the
File menu, or reset the default using Options on the Tools menu (see section 3.11.1).
This Options menu can be used to reset all the Maplesoft default if you wish.

A worksheet (see figure 3.2) is a window created by Maple containing input regions
(printed in red), output regions (printed in blue) and text regions (printed in black).
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Figure 3.2: The Maple Window

These are collected into execution groups consisting of lines of text and/or input com-
mands. When you press <Enter> with the cursor anywhere within an input region of an
execution group, all of the commands in that group are executed and their outputs are
placed at the end of the group. Each execution group is indicated by a left square bracket
[ and each region within an execution group is called a paragraph.

Execution groups in a worksheet, or material in any Maple window, may also be
organised into expandable sections indicated by a grey triangles in front of their headings.
When you click the left mouse button on the triangle, an expanded section is collapsed
(hidden) and a collapsed section is expanded — there is one of each in figure 3.2. We will
not discuss the creation of expandable sections in these Notes, but you will see them in
the Maple help pages, for example.

It is possible to have several worksheets open at the same time. Each worksheet can
be printed as a separate document (see section 2.8), and has its own window manager
allowing you to raise, move or resize it. The worksheet which is ‘on top’ (i.e. which has
been raised) is called the active worksheet.

3.5 The Menu Bar
The menu bar is at the top of the Maple window. Depending on what type of region

the cursor is, some of these menus will be greyed out. For example, the Plot menu is
greyed out in figure 3.2, but if the cursor were over the plot of sinx , it would become
active.
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Before looking at individual menus, note that some options are on/off switches. If
there is a ticked box in front of one of these options, that switch is ‘on’. To toggle a
switch (i.e. change it from ‘on’ to ‘off’, or vice versa) you just need to click in the box
and then (usually) click on an ‘OK’ button.

Most of the options on these menus are reasonably straightforward, particularly if you
are used to using standard programs such as Word on Microsoft Windows, and so we will
only look at the menus, or options on menus most immediately relevent to using Maple
efficiently. Many of these useful option have icons on the tool bar, and it is usually quicker
to use the icons (see section 3.13).

3.6 The File Menu
There are fourteen options on this menu, manly used for saving and opening work-

sheets. Some of these options pop up a new little window called a dialogue box. We
will outline here all that you need to know to use these boxes. If you wish to make use of
the advanced features, see the help files for further information.

New : Open a New Worksheet.
This option opens a new worksheet or document and makes it the active worksheet.

We have set the default to open a new window, but the Maplesoft default opens a new
tab.

Save and Save As : Save the Active Worksheet in a File.
If you select Save and the active worksheet has a name, it will be saved (as a work-

sheet) in a file with that name. If it has no name, or if you select Save As..., the
Save As dialogue box mentioned in section 1.4 will appear and you can follow the same
procedure as given in that section to save your work. At the bottom of this dialogue box,
you will see (as in section 2.23) a box which looks something similar to:

Maple Worksheet ∇
If you now click on the symbol ∇ , a menu will appear giving you two choices for the
type of file in which you can save your worksheet.

Maple Worksheet files (extension .mw) which are stored as XML files.

Maple Classic Worksheet files (extension .mws), which are stored in a format used for
Maple 8 and earlier versions.

Note: If the filename has no extension (or the wrong one), then the correct one will
be added onto the end.

Export As .

This option was is essentially the same as Save As, except that at the bottom of this
dialogue box, you will see (as in section 2.23) a box which looks something similar to:

HTML (htm, html) ∇
If you now click on the symbol ∇ , a menu will appear giving you 9 choices for the type
of file in which you can save your worksheet. Most of these you should not use, but those
that will be relevant are

HTML (.html or .htm) which produces a webpage suitable for upload to a webserver.

PDF (.pdf) which produces a PDF version of the worksheet.
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LaTeX (.tex) which are processed by the mathematical wordprocessor LATEX (as an
example, these notes were prepared using LATEX).

Maple Input (.mpl) which contain just input and text regions. This is useful if you
want to write Maple scripts that can the executed without using the GUI using just
the commandline version of Maple. This is not something that you will need to do
in any first year mathematics course at UNSW.

Maplet (.maplet) which produces files that be used without by the Mapleviewer. You
will not need this.

Maple Text (.txt) which is an ASCII form of the worksheet. It is meaningful to all
versions of Maple and humans and contains output. The different types of regions
are preserved as follows:

• all lines in input regions are saved as lines starting with >;

• all lines in text regions are saved as lines starting with #;

• all output is saved in a very simplistic format (which — despite the name
‘prettyprint’ given to it by Maple — is sometimes hard to read).

Plain Text (.txt) which are almost the same as Maple Text files except that lines in
text regions are saved without the leading #. This means that these lines will be
ignored when you try to open them (see below).

Maple T.A. (.zip) which can be used by Maple TA instructors for preparing Maple TA
questions and assignments. You will not need to do this.

Note: If the filename has no extension (or the wrong one), then the correct one will
be added onto the end.

Open...

This option was described briefly in section 2.23 (using a button from the tool bar). It
is the same as New, except that it places a file from your directory into the new worksheet.

When you select Open, a dialogue box will appear similar to the one for the option
Export As... above. In each case, a list of your directories and all the files whose
names end in the appropriate extension (e.g. *.mw) will be displayed, and you may either
click on one of these or type a name yourself.

If you open a Maple Worksheet, then the new worksheet will look exactly like the
worksheet you saved under that name.

If you select Maple Input then the input lines from the .mpl file are placed in Maple
input regions.

If you select Text, then after selecting the name of the file the dialogue box will be
replaced by another one giving you a TextFormat Choice of Maple Text, Plain Text
or Maple Input. If you choose the Plain Text format, the contents of the file will be
put into a text region in the new worksheet exactly as they look in the file, which is not
usually of much use. If you choose Maple Input all the file will be put into input region
exactly as it is (which would include a prompt if there is one), unless it is a text region
(which is ignored). If you choose the Maple Text format,

• all lines starting with > will be put into input regions;
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• all lines starting with # will be put into text regions;

• all other lines will be ignored.

Warning: In all three cases above, the file is included in the new worksheet and
appears on the screen (possibly including output), BUT it has NOT been processed by
the Maple processor at this session: it is as though you entered it all using the editing
features. If you want to make corrections or changes first, then you may need to go
through the whole text, pressing <Enter> on every command line (after making the
changes) as described in section 1.3.7. If you want all the commands to be executed just
as they are, then click the Execute Icon (three exclamation marks).
Notes:

1. If you open a Maple Input File or a Maple Text file then all the commands are
placed in the same execution group. This is rather annoying.

2. A list of the most recently opened files will also appear on the File menu, if you
have ever used this feature. Clicking on the name opens the file.

Exercise
Restart Maple and open the file exercise.mw that you made in the last
exercise. Use the mouse pointer in the scroll bar to move around on the
screen. Note that the output regions are as you would expect. Move the
pointer to the last empty input region (i.e. the last empty line with a >)
and click the left mouse button to bring the screen cursor to that point,
then type

c;

You do not get anything except for the unassigned value c. Why? Well
you have not sent anything to the Maple processor yet. To do so, move the
cursor up to the top line (the a := command line) and press <Enter>
on each line.

Leave this session on the screen for the next exercise.

Close... : Close the active worksheet or document.
If you select the appropriate Close... and have made any changes to the active

worksheet or document since the last time you saved it, Maple will ask you if you want
to save it before closing. Otherwise it will simply close it.

Print : Print the active worksheet.
When you select Print, a dialogue box will appear giving allowing you to print the

worksheet directly or to a file. There are tabs to change the appearance of the printout,
but we advise you to leave these alone. If you just click on print, then your worksheet is
printed on one of the lab printers (see the lab notes for details).

If you tick the Print to File box, then a dialogue box will prompt you for a file name,
the default given being out.ps — the .ps extension telling you it is a PostScript file.
You can then view this file with a postscript viewer. The file manager on the Linux PCs
in the lab knows how to open view this file. Note that you might find the Export as PDF
option described above to be a more convenient way to ‘print to file’.
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Print Preview

Gives you a preview of the worksheet to be printed before proceeding to the Print
Dialogue Box.

Exit : Terminate the Whole Maple Session.
If you select Exit, then Maple will close all worksheets and documents before termi-

nating the whole session. If you have made changes to any worksheet or document since
the last time you saved it, Maple will ask you if you want to save before closing.

3.7 The Edit Menu
This menu deals mainly with deleting or moving highlighted material using Maple’s

clipboard. This clipboard is similar to (and uses) the mouse clipboard.

Highlighting Material : Select All and Find ...

Material in a Maple window can be highlighted using the mouse in the usual way. You
can also highlight the whole of a worksheet by selecting the option Select All from the
Edit menu.

Sometimes you may wish to find (or find and replace) some text in the worksheet.
You can move the cursor to the text you want using the Find ... option. When
you select this option, a Find/Replace dialogue box will be opened asking for this text,
any replacement text and whether you want to find (or find and replace) its Next or
Previous occurrence. After you have typed the text and clicked on either the Next or
Previous button, the text you asked for will be highlighted, and clicking on Change
will change it. The dialogue box can be closed by clicking the Cancel button.

Copying, Moving and Deleting Material: Cut, Copy and Paste

These three operations can either be carried out via the Edit menu or using their
icons in the tool bar in the usual way. You can use the Tool Tips (see section 3.11.1) if
you cannot work out which is which.

To copy any material, highlight it (as above) and click the Copy icon or select Copy
from the Edit menu. This places a copy of the material into the Maple clipboard. Move
the cursor (using the arrow keys or the left mouse button) to just before where you want
to insert the material. Then click on the Paste icon or select Paste from the Edit menu.
What is in the Maple clipboard will be inserted at the cursor.

You can also copy a block of material from one Maple window or worksheet to another.
This is especially useful for copying examples from a Maple Help window into a worksheet
to try them out. There is no need to retype the examples: simply select them in the Help
window, copy them to an input region in a worksheet and then press <Enter>. If you
want to copy all of the examples on a Help page, select Copy Examples from the Edit
menu when the Help page is active.

To delete any highlighted material, select the Cut option or Cut icon. Material which
is deleted in this way is not completely lost because it is stored in the Maple clipboard
(replacing whatever was in the clipboard before). If you DO NOT want it to be stored in
the clipboard, press <Delete> instead of the Cut option.

All these action have keyboard shortcuts, just as Kwrite does — and they are in fact
the same shortcuts

Note: The Maple clipboard only contains the last thing that was placed in it, no
matter what procedure placed the material there.
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You can delete the whole paragraph containing the cursor by selecting Delete El-
ement. Note that input and output regions in an execution group are separate paragraphs
and so deleting one of them in this way does not delete the other one.

It is also possible to remove the output regions from either all of the highlighted
commands or all output regions by selecting the option Remove Output at the bottom
of this menu. This can be useful when you want to remove all results and save only the
text and input regions for later.

Editing Exercises

1. Make sure the Maple commands of the last two exercises are in the active worksheet
(together with their results).

To repeat these commands for (x-2)^5, use the arrow keys to move the cursor
back to the first line and place it between the x and the + . Press <Delete> and
then type - . Replace the 4 with a 5 in the same way. Now, with the cursor on
this first line, press <Enter>. Note that the earlier result is replaced by the result
of the new calculation. Note also that only this result changes (and not the others
further down) and that the cursor is at the end of the next command line.

Now move the cursor down to the last command line and press <Enter>. You
get no change in the result for c . This is because b has not been changed and
therefore you are recalculating exactly what you did before.

So go back to the previous line and press <Enter>. You do not get what you might
expect. The % symbol refers to the last thing that was sent to the Maple processor
and NOT to the result in the line above the active line. In this case the last thing
sent to the Maple processor was the command c := int(b,x); .

To fix it up properly, go all the way back to the first input line, press <Enter> and
then press <Enter> again on the second and third lines. Try it.

2. Highlight the first line using the mouse. Note that the > prompt is not in the
highlighted text. Use the Copy icon to copy the highlighted section into the Maple
clipboard. Move the cursor to the blank input region at the end of the worksheet
and use the Paste icon to paste it there. The command a := (x-2)^5 appears
in this line.

Change the 5 to 6 , and press <Enter> to execute the new command.

3. Open the help window for int (either by using the Help Browser or typing ?int
as in section 1.5) and scroll to the Examples. Use the mouse to highlight the first
example. Now click the Copy icon.
Open a new worksheet, move the cursor to the blank input region at the end of
that worksheet and click the Paste icon. The example that you highlighted appears
on this line: press <Enter> to execute it.
Close this worksheet (you will be using the previous worksheet in the next exercise).
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Recovering from an Error : Undo result and Redo

Sometimes you make a mistake when editing (such as unintentionally deleting a whole
worksheet!). When this happens, you can recover from your mistake by selecting Undo
result before you do anything else (such as executing a command or doing further
editing). The Undo result itself can be undone by selecting Redo. Both these options
also have icons in the tool bar.

Execute .

This option will execute either all of the highlighted commands or all the commands
in the worksheet, depending on which you choose.

3.8 The View Menu
Tool Bar, Context Bar, Status Bar etc

These are just on/off switches which control whether you can see the relevant things.
When they are on, they show you the corresponding regions of the Maple window.

Palettes .

This option allows you to open up and arrange the pallettes (see sections 1.2.1 and 3.14)
which can be build up mathematical expressions, especially when you are not sure of the
Maple syntax.

Zoom Factor .

This allows you to set the worksheet characters to various sizes. We have set the
default to be 150%, but you may prefer to return it to the Maplesoft default of 100%.
There are icons in the tool bar to zoom to 100% and 200%.

Hide Content .

This collection of switches allows you to supress various parts of the worksheet: spread-
sheets, input, output or graphics.

Show/Hide Contents ... options
These are more on/off switches that control whether, for example, boundaries of col-

lapsible sections and execution groups are visible on not.

3.9 The Insert Menu
Inserting new regions : Execution Group and Paragraph

These options allow you to insert a new Execution Group or Paragraph respectively.
In each case a second menu pops up, asking you whether you want to put the new region
Before or After the line the cursor is on.

If you select Execution Group, then the new line will be an input region, and if you
select Paragraph, then the new line will be a text region.

Inserting new text or input : Text, Standard Math, Maple Input and
Standard Math Input

Normally when you type anything into an input region, it is treated as Maple input
(indicated in red) and when you type anything into a text region, it is treated as text.
You can alter this by selecting Text to insert text into an input region or Maple Input
to insert input into a text region.
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The 2D-Math options are discussed in section 3.14.

Exercises Check that the Maple commands of the previous exercises are on the screen.

1. Move the cursor to the output region of the first line. Insert a text region above it
by using the Paragraph option in the Edit menu. Enter

this is an example

(it will printed in black instead of red). Using <Enter> will give you a new line of
text, and you can continue adding comments.

2. Create an input region after the above execution group using the Execution
Group option in the Insert menu. Now type in the comment

# this is an example

(it will printed in red) and press <Enter>. This puts you on the line

b := expand(%);

To add more lines of comments using #, insert another input region and type in the
comment beginning with # etc.

Page Break
This puts a page break at the cursor. On the screen this looks like a line across the

workshet with the words “page break” in the middle, but when you print the worksheet
a new page is taken at that point.

3.10 The Format Menu
The options in this menu are used to control the look of individual characters or

words, such as their type-face (font) or size, or the positioning of paragraphs within the
worksheet. We advise you not to get too involved with this menu at this stage. Note that
any change you make only refers to the highlighted text or the current paragraph, and
most only apply to text regions.

3.11 The Tools menu
This menu contains various assistants, tutors and tools such as a spellchecker and more

importantly an option for setting the look and feel of the Maple interface: the Options. . .
submenu.

3.11.1 The Options submenu
This is a submenu of the Tools menu. When you select this a dialogue box opens that

allows you to reset global options. These can be applied either to the current Maple session
(when you restart Maple everything reverts to the default options) or applied globally,
(they stay as you have chosen them until you change them yourself). We recommend you
leave most of the settings as the defaults we have chosen. If you experiment, then you
ought to make sure you select the “Apply to Session” option so that the global defaults
are not changed.

There are six tabs on this dialogue box, grouping together the different types of
settings. Click on the tab to change to a different set. For further detail, see the Maple
help page worksheet,managing,preferences.
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General
The two interesting options here are AutoSave and Kernel Mode.
If you tick the Enable AutoSave box then Maple will save your worksheet every 3

minutes (you can change the time gap if you wish). The file is saved as a Maple Worksheet,
but is not given the .mw extension, instead it is called something like file_MAS.bck,
and is overwritten each time.

For Kernel Mode, the default is Parallel and this means that each Maple worksheet
is independent. If you select Shared, each Maple worksheet shares the same kernel , that
is, what is defined in one worksheet is the same as in the others (see section 2.2.3). With
Mixed mode, you are asked what you want with each new worksheet.

Display
This group controls the style used for input and output of results. The important

options here are the following (we recommend you leave the others as the defaults) Input

Display

This group allows you to choose whether your input is Maple Notation or 2D Math.
The Maplesoft default is 2D Math, but we have reset the default to Maple Notation. See
section 3.14.

Output Display

This group allows you to switch between different types of output. It is initially set to
Typeset Notation which is the best looking output and allows you to select subparts
of the output and paste them into an input region. The option Character Notation
stands for the type of output you get when Maple is not using the graphical user interface
(known as prettyprinting). The option Maple Notation gives a Maple-readable type
of output that can be used directly for input. This makes it useful for files which you
intend to read into a Maple session by means of the Maple read command.

Assumed Variables

This group determines the way in which assumed variables will be presented.

Plot Display

This allows you to choose whether the next plot will be inserted Inline (i.e. in the
worksheet itself) or in a Window (i.e. a separate worksheet). The first possibility allows
you to print an integrated worksheet, and the second allows you to print the plot on its
own.

Interface
This tab allows you to set the main “look and feel” parameters. This is where we

made the majority of the changes from the Maplesoft defaults. In particular:

1. New worksheets open in new windows (the Maplesoft default is a new tab).

2. Default Zoom is set to 150% (Maplesoft default is 100%).

3. Default Format is Worksheet (Maplesoft default is Document).

4. We have set Large Toolbar Icons.

Export
This tab allows you to control some of the aspects of the ways Maple saves and exports

worksheets and documents. You shouldn’t need to change these settings.
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Precision
This tab allows you to control the number of digits Maple uses in its calculations and

displays: it is similar to resetting the global variable Digits.

Security
This tab is for features you will not have any use for in first year.

3.12 The Help Menu
We have already looked at the most important options in this menu in section 1.5.

To find out about the rest, select the option “Using the Help System” under “Manuals,
Dictionary, and more” and follow the links which interest you.

3.13 Alternatives to Commonly Used Menu Options
There are two shorter alternatives to the menus for many commonly used commands,

one of which uses the mouse and one of which uses the keyboard.

3.13.1 The Tool Bar
Some of the options from the menus in the menu bar can be replaced by clicking the

left mouse button on one of the buttons in the tool bar. The STOP button is described
in section 1.3.3, and the first 13 buttons are the New, Open, Save, Print and Print
Preview options from the File menu, the Cut, Copy, Paste, Undo and Redo
options from the Edit menu and buttons to insert a new Text or Maple Input region
after the cursor.

The other useful icons in this bar, are the two execute icons at the end (the triple and
single exclamation marks) and the restart icon (looped arrow).

3.13.2 Keystroke Alternatives
Only relatively few of the options from the Maple menus are included in the tool bar.

On the other hand, many of the options can be replaced by typing a combination of keys.
For example, you can terminate a Maple session by typing <Alt> -F4 (as described in
section 1.3) instead of selecting Exit from the File menu. Whenever such an alternative
is possible, it is printed alongside the option in the menu.

3.14 2D Math input
You can avoid some of the Maple syntax described in chapter 7 by entering expressions

in 2D Math notation, i.e. in a form as close to the usual Mathematics style as a keyboard
(and the palettes) will allow. This is also how you enter a command in Maplesoft’s default
document mode.

For example, you can enter the expression 3t2 + 2t as it is printed (Maple uses a
centered dot ( · ) for the multiplication) or use the expression palette to directly enter∫

3t2 + 2t dt in the worksheet.
Note that if the input is set to be Maple notation (our default), the palettes put in

the appropriate Maple command.

To enter an expression in this way, you first need the Input Display to be set to 2D Math
Input. This can be done either by selecting Standard Math Input from the Insert
menu, or clicking (the left mouse button) on the word “Math” in the context ba; these
changes only affect one input region. Now do the following:
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1. Open the palette dock by clicking on the right pointing triangle in the left edge of
the worksheet.

2. Open the expression palette by clicking on the appropriate grey triangle

3. Click on the
∫
f dx symbol.

4. Type the expression you want to integrate, using the caret ^ for a power and the
down arrow key to go back down.

5. Use the <Tab> key to move the the next part of the expression (the variable of
integration and type t .

6. Press <Enter>. There is no need for a colon or semi-colon.

There are a large number of palettes with various things you might wish to enter. If
you want to use them, then you may — it is even acceptable to use 2D Math notation in
the laboratory test if you wish

3.14.1 Symbol recognition
The top palette (which is open by default) is for symbol recognition. This allows you

to draw an approximation to a symbol and ask Maple to make a guess at what you mean.
Draw the symbol by holding down the left mouse button in the scratchpad and then click
on the right button to ask Maple to guess. The left button clears the scratchpad.

If Maple comes up with the symbol you want, click on it and it will be entered at the
cursor position in the worksheet but only if the Input Dispaly is 2D Math.
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SUMMARY OF MAPLE COMMANDS.

General
<Ctrl>-F4 emergency exit
# indicates a comment
; indicates end of a command
: same as ; but suppresses display of the result
?item get Maple’s ? help on item
variable := expression; assignment operator
var := ’var’; unassign variable var
restart unassign all variables
expr1 = expr2 equation
%, %%, %%% last, second last and third last results
<Shift>-<Enter> continue a command to the next line
eval(structure) the contents of the structure
print(expr) print expression or content of structure
expr1, expr2,. . . a sequence
{sequ} convert a sequence into a set
[sequ] convert a sequence into a list
op(list or set) convert list or set into a sequence
expr$n expr , expr ,. . . repeated n times
read(file) read in and carry out commands in file
unassign(’var1’,. . .) unassign variables var1, . . .

Arithmetic
+, -, *, / arithmetic operators plus, minus, times, divide by
^, ** raise to a power
! factorial
Pi, I, infinity the constants π ,

√
−1 and ∞

Digits := number set number of floating point significant digits
evalf(expr) floating point value of expression
evalf(expr, digits) floating point value to this many digits
convert(float, fraction) convert floating point to fraction

Complex arithmetic
evalc(expr) evaluate expression in I as a complex number
Re(expr) real part
Im(expr) imaginary part
conjugate(expr) conjugate
abs(expr) complex modulus
argument(expr) argument (in range −π < arg ≤ π )
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Algebra: Simplification
expand(expr) expand expression
combine(expr) combine expression into a single term
combine(expr, option) combine using option
simplify(expr) simplify expression
simplify(expr, option) simplify using option
normal(expr) simplify sums of rational expressions
factor(poly) factor a polynomial over the rationals
collect(expr) collect coefficients of like powers
radsimp(expr) simplify radicals in expression

Algebra: Selecting, sorting and substituting
numer(expr) numerator of rational expression
denom(expr) denominator of rational expression
coeff(poly, var, power) coefficient of variable to power in polynomial
lhs(eqn) left hand side of equation
rhs(eqn) right hand side of equation
op(n, expr) select nth part of expression
name[n] select nth component of sequence, list or set name
sort(list or poly) sort a list or polynomial
subs(expr1=expr2, expr3) substitute expr1 with expr2 in expr3

Algebra: Solving
solve(eqn, var) solve equation for variable
solve({eqn,. . .}, {var,. . .}) solve a set of equations for a set of variables
assign(soln) assign variables in solution of equations
RootOf(poly) expression for an arbitrary root of polynomial
allvalues(RootOf-expr) all values of the roots of polynomial
fsolve(eqn) finds a real root of an equation
fsolve(eqn, var, lo..hi) all roots within range
fsolve(eqn, var, complex) all complex roots

Functions (for mathematical functions, see table in Chapter 2)
name := proc(vars) commands end proc procedure definition
name := (vars) -> expr function definition

Plotting
plot(expr, var=start..end) plot expr for var from start to end
plot(expr, var=start..end, lo..hi) as above but with range from lo to hi
plot([expr1, expr2, param=start..end]) parametric plot
plot([expr1,. . .], var=start..end) multiple plots on same axes
polarplot(expr, var=start..end) polar plot of r = expr for var from start to end
polarplot([expr1, expr2, param=start..end]) parametric polar plot
implicitplot(eqn,var1=start..end, var2=lo..hi) implicit plot
plot3d(. . .) see Maple’s Help Browser
with(plots) load Special Plotting Package
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Calculus
diff(expr, vars) differentiate expression with repect to vars
D(function) derivative of a function of one variable
D[n](function) derivative of a function with respect to its nth argument
D[n1 , n2 , . . .](function) derivative respect to argument n1 then n2 , . . .
int(expr, var) integral of expr with respect to var
int(expr, var=lo..hi) definite integral of expr for var from lo to hi
limit(expr, var=value) limit of expr as var approaches value
limit(expr,var=value, left) limit from the left
limit(expr,var=value, right) limit from the right
sum(expr, var=lo..hi) sum of expr for var from lo to hi
product(expr, var=lo..hi) product from lo to hi
Diff, Int, Limit, Sum, Product inert versions

Other Calculus
taylor(function, var=value, order) Taylor series about var=value
convert(t-series, polynom) convert a Taylor series to a polynomial
dsolve(ODE, y(x)) solve ODE in derivative of y(x)
dsolve({ODE, conds}, y(x)) solve ODE subject to conditions like

y(0)=1, D(y)(0)=1

Student Calculus Package
with(student) load student calculus package
changevar(old-expr=new-expr, inert-expr, new-var) change of variables
value(inert-expr) evaluate an inert integral etc.
intparts(inert-int, u) integrate by parts
convert(integrand, parfrac, var) convert to partial fractions
rightbox(expr, var=lo..hi, n) Riemann sum plot
leftbox, middlebox similar
rightsum(expr, var=lo..hi, n) Riemann sum calculation
leftsum, middlesum similar
simpson(expr, var=lo..hi, n) apply Simpson’s rule
maximize(function) find maximum value of function
minimize(function) find minimum value of function

LinearAlgebra Package
with(LinearAlgebra): load LinearAlgebra Package
<sequence> create a Vector
<Vector1 | Vector2 | ...> create a Matrix
<M1 or v1 | M2 or v2 | ...> augmented matrix (side by side)
<M1 or v1 , M2 or v2 , ...> stacked matrix (on top of each other)
Vector[i] ith element of vector
Matrix[i, j] (i,j)th element of matrix
Row(Matrix, i) ith row of matrix
Column(Matrix, j) jth column of matrix
SubMatrix(Matrix, a..b, c..d) submatrix with
SubMatrix(Matrix, list, list) all other rows and columns deleted
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map(f, Matrix) apply the function f to every element of Matrix
IdentityMatrix(n) identity matrix of size n
Vec1.Vec2 dot product
CrossProduct(Vec1, Vec2) cross product
RowOperation(Matrix, [r1, r2]) swap rows
RowOperation(Matrix, row, multiple) multiply row by constant
RowOperation(Mat, [r1, r2], mult) replace r1 by r1 plus mult times r2
BackwardSubstitute(echelon) backsubstitution on echelon form (assumed augmented)
GaussianElimination(Matrix) row echelon form
ReducedRowEchelonForm(Matrix) fully-reduced row echelon form
LinearSolve(Mat, Vec) solve system of equations
Transpose(Matrix) transpose of Matrix
NullSpace(Matrix) kernel of Matrix
Rank(Matrix) rank of Matrix
Determinant(Matrix) determinant of Matrix
MatrixInverse(Matrix) inverse of Matrix
CharacteristicPolynomial(Matrix, t) characteristic polynomial in variable t
Eigenvalues(Matrix) eigenvalues of Matrix
Eigenvectors(Matrix) eigenvalues and eigenvectors of Matrix

Assuming Properties
assume(var, property) assume variable has property
additionally(var, property) assume further property
about(var) display properties of variable

Local Firstyear Package
sortc(list) sort a list of complex numbers
complot(sequ) plot a sequence of complex numbers
solveplot(eqn, var) plot solutions of equation in complex plane
polytoVect(poly) convert polynomial to coordinates (standard basis)
Vecttopoly(vec) convert Vector to corresponding polynomial (standard basis)

Discrete Maths — see section 2.17
Programming — see sections 2.19, 2.20
Et cetera — see Maple’s Help Browser
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aborting, 6
about, 51
absolute value, 18, 31
abuse of notation, 57
active worksheet, 63
additionally, 51
allvalues, 30
and, 51
angle, 45
arcsin, 17
arcsinh, 17
argument

of a complex number, 31
of a procedure, 16

arithmetical operations, 13
arrow operator, 21
assign, 29
assigning solutions, 29
assignment of variables, 14
assignments, 58
assuming properties, 50
augmented matrices, 40
augmenting matrices, 39
automatic saving in Maple, 71

back-quotes, 53, 58
back-substitution, 41, 42
backsub, 42
balloon help, 62
basis, 42
binomial, 18
boolean, 51
braces, 33
brackets, 57
break, 54
built-in functions, 17

ceiling, 18
center, 45
change of variable, 36

characteristic polynomial, 43
checking

solutions, 29
coeff, 26
coefficient, 26
collect, 20
colon, 18, 41, 46, 53, 55
ColumnSpace, 43
combine, 20
command files, 58
commands

aborting Maple, 6
changing Maple, 7
entering in Maple, 4

comments
in Maple, 6

common
denominator, 20
factors, 20

complex
arithmetic, 31
numbers, 31
solutions, 30

conditions, 51
conjugate, 31
constants, 15

scalar, 44
context sensitive menus, 6, 39, 43
convert, 14, 24, 25, 49
coordinates, 45
cos, 17
cosec, 17
cosech, 17
cosh, 17
cot, 17
coth, 17
cross product, 44
curves, 31

implicit, 34
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parametric, 34
polar, 34

D, 22, 48
defaults, 62
defining functions

arrow, 21
as procedures, 55

denominator, 26
common, 20
rationalising, 20

dependent variable, 17
derivative, 21

higher order, 22
partial, 47

Determinant, 43
dialogue box, 3
dictionary, 9
Diff, 36
diff

in Maple, 21
difference equations, 50
differential equations, 47
differentiation, 21

implicit, 23
implicity, 23
partial, 47
repeated, 22

Digits, 14
discrete mathematics, 49
distance, 45
dot product, 44
double-quote, 68
dsolve, 47
dummy variable, 21, 30

e (base of natural log), 57
Eigenvalues, 43
Eigenvectors, 43
entering, 4
entry, 38
Equation, 45
equations, 26, 28

difference, 50
differential, 47
simultaneous linear, 40

errors, 42
Euclidean algorithm, 49

eval, 21, 56
evalc, 31
evalf, 14, 27, 31, 37
evaluation, 14, 19, 21, 36, 37, 42, 56

complex, 31
exact solutions, 29
execute icons, 72
execution groups, 4
expand, 20
expansions, trig, 20
exponential, 18, 57
expressions, 17

factor, 20
factorial, 13
factorizing, 18
factors, common, 20
Fibonacci

numbers, 50, 56
recurrence, 50

file
reading in to Maple, 58

Float, 14
floating point, 14
floor, 18
for, 52, 53
fractional part, 18
fractions, partial, 24
fsolve, 30
functions, 17

arrow, 21
arrow operator, 21
built-in complex, 31
defining, 55
elementary, 24
hyperbolic, 17
mathematical, 18
piecewise, 33
rational, 20
several variables, 21
trigonometric, 17
warning, 17

gamma, 15
gausselim, 42
Gaussian elimination, 40
gcd, 18, 49
general root, 30
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general solution, 42
geom3d, 44
geometry, 44

3D, 44
graphs, 31

intersections of, 33
greatest common divisors, 49
GUI

Maple, 61

help
Maple, 9

Help Browser, 9
Help Navigator, 9
hyperbolic functions, 17

i (square root of −1 ), 15
identity matrix, 39, 44
if - then, 52
imaginary part, 31
implicit differentiation, 23
implicitplot, 34
independent variable, 17
inequalitities, 51
inert procedure, 35, 49
infinity, 15, 21, 24
initial conditions, 48
input

region, 4
Int, 36
int, 23
integration, 23

by parts, 36
by substitution, 36

intersection, 45
inverse matrix, 43
isprime, 51

kernel, 43

last result, 5
lcm, 18, 49
least common multiples, 49
leftbox, 36
lefthand side, 26
leftsum, 36
length, 44
lhs, 26

like powers, 20
Limit, 36
limit, 21

one-sided, 21
line, 45
LinearAlgebra, 43
linsolve, 42
list, 24
lists, 25, 34

adding to, 26
selecting from, 26

loading functions, 18
logarithm, 18
logical connectives, 51
loop, 52

map, 27
Maple, 2

2D Math, 72
aborting commands, 6
AutoSave, 71
changing commands, 7
clipboard, 67
comments, 6
common errors, 57
context sensitive menus, 6, 39, 43
copying text, 67
defaults, 61, 62
deleting text, 67
Dictionary, 9
documents, 62
double-quote, 68
e , 57
Edit menu, 67
editing, 67
entering commands, 4
execution group, 63
expandable section, 63
exponential, 18
exporting, 8
File menu, 64
Format menu, 70
full command name, 6
help, 9
Help menu, 72
Help Navigator, 9
i , 15
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∞ , 15
Insert menu, 69
inserting input regions, 6, 7
Math palettes, 3
Math palettes (closing), 3
Math palettes (opening), 3
menus, 2
opening Maple Worksheets, 58
packages, 18
palettes, 72
paragraph, 63
percent, 5
π , 15
printing, 71
quitting, 3
regions, 62
reserved names, 15
restart, 72
save, 8
Save icon, 8
Search, 9
settings, 61, 62
Stop icon, 6
Tools menu, 70
View menu, 69
worksheets, 3, 62
add, 28
full command name, 39, 43
module, 39, 43
mul, 28
range, 32

Maple Input files, 8
Maple Worksheet, 4

opening, 58
mapleinit, 59
Maplesoft default settings, 62
Maplesoft defaults, 71
mathematical functions, 18
Matrices, 24, 37

arithmetic, 43
augmented, 40
by combining Vectors, 39
columns, 39
combining, 39
diagonal, 39
identity, 39
in polynomials, 44

index functions, 38
inverse, 43
multiplication, 43
names, 38
operations on, 43
rows, 39

maximum, 18, 23
menu

context sensitive, 6, 39, 43
menus, 63
middlebox, 36
middlesum, 36
minimum, 18, 23
mod, 49
modular arithmetic, 49
modulus, 31
Moodle

Maple, 11

next, 54
normal, 20, 45
not, 51
notational abuse, 57
numerator, 26

op, 25, 26
operands, 26
operations

arithmetical, 13
on equations, 28

operations, row, 40
option remember, 57
Options, 70
or, 51
order, 13, 25
ordinary differential equations, 47
output

region, 4

package
geom3d, 44
LinearAlgebra, 43
plots, 34
student, 35

packages, 18
page break, 70
parameters, 42, 43
partial derivatives, 47
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partial fractions, 24
percent, 5
π , 15
piecewise functions, 33
plane, 45
plot, 32

buttons, 32
scaling, 33

plot3d, 35
plots

3D, 35
comparing, 33
implicit, 34
package, 34
parametric, 34
polar, 34

plotting, 31
point, 45
polarplot, 34
polynomial, 26

characteristic, 43
sorting, 27
Taylor, 49

Power, 49
precedence, 13
prettyprint, 71
prime numbers, 51
principal value, 31
print, 53, 56
printf, 53
printing

graphs, 33
problems

common Maple, 57
procedure, 55

inert, 35, 49
recursive, 56

Product, 36
product, 28

cross, 44
dot, 44

properties, 50
punctuation, 57

radicals, 20
radsimp, 20, 50
range, 30, 32

rank, 43
rational functions, 20
reading in files, 58
real part, 31
recalculation, 57
recurrence relations, 50
regions, 4
remainder, 49
remember, 57
repetition, 22, 25
reserved names, 15
restart, 16
restart icon, 72
result

last, 5
return, 56
rhs, 26
Riemann sum, 36
rightbox, 36
righthand side, 26
rightsum, 36
root, general, 30
RootOf, 30, 31
round, 18
row operations, 40
RowOperation, 40
RowSpace, 43
rref, 42
rsolve, 50

scalar constants, 44
scaling, 34
sec, 17
sech, 17
section

expandable, 63
selecting, 26

from Matrices, 38
from sets and lists, 38
from Vectors, 38
operands, 26

seq, 25, 34
sequence, 24

of repetitions, 22
series, Taylor, 48
set, 24
set algebra, 49
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sets, 25
significant digits, 14
simplify, 20
Simpson’s Rule, 36
sin, 17
sinh, 17
solutions

checking, 29
complex, 27, 30
exact, 29
floating point, 30
general, 42
not finding, 30
ranges for, 30
selecting, 27
simplifying, 31
to linear equations, 42

solve, 29
solving, 29

difference equations, 50
differential equations, 47
polynomial equations, 29
recurrence relations, 50
several equations, 29
simultaneous linear equations, 40

sort
in Maple, 26

sorting
in Maple, 26

sphere, 45
square root, 18
structure, 24
student, 35
SubMatrix, 40
subs, 19
substituting, 19

in list, 27
in set, 27

Sum, 36
sum, 27

Riemann, 36
supressing output, 18, 41, 46, 53, 55
switches, 64
symbol recognition, 73

tan, 17
tanh, 17

Taylor polynomials, 49
Taylor series, 48
text region, 4
tick marks, 33
toggle, 64
Transpose, 43
trigonometric

expansions, 20
functions, 17

truncate, 18

unassign, 15
unassignment, 15
underline character, 15
unknown, 14

value, 14, 36, 37
principal, 31
returning, 56

variable, 14
change of, 36
dependent, 17
dummy, 21
independent, 17
names, 15

Vectors, 24, 37
arithmetic, 43
index functions, 37
operations on, 43
selecting entries, 38

warning
assigning values, 16
defaults, 70
functions, 17
reserved symbols, 38
using read command, 59
worksheets, 16

while, 52, 53
window

Maple, 2, 61
with, 18
worksheet

active, 63
Maple, 3, 4
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